


Introducing Norton System Doctor

    Demo (approx 2:20)
Norton System Doctor continuously monitors your computer to keep it free of problems and running at 
peak efficiency. It can alert you immediately when conditions require attention, and can fix many problems 
automatically, without interrupting your work.
The Norton System Doctor main window is a panel of sensors that can monitor just about every aspect of 
your computer system, including the disks, memory, CPU, and network. Norton System Doctor sensors 
include alarms that alert you to critical conditions requiring attention. The sensors also provide information 
that can help you fine-tune the performance of your computer. Double-click any sensor for a brief 
description of what it does.

While the default settings are ideal for most users, Norton System Doctor is completely customizable. 
For example, you can:

Specify the conditions Norton System Doctor monitors by adding and removing sensors.
Select the critical conditions you want Norton System Doctor to fix automatically.
Run Norton System Doctor minimized or docked to preserve valuable desktop space.

To take full advantage of the monitoring capabilities of Norton System Doctor, leave it running at all 
times. You can specify that Norton System Doctor run automatically whenever Windows starts.

To begin monitoring your system now, click here        to open Norton System Doctor.

{button ,AL(`About sensor alarms;To hide and show sensors;Types of sensors;To add or remove 
sensors;Customizing Norton System Doctor;To choose Norton System Doctor startup options;to dock 
and auto hide Norton System Doctor',0,`',`')}    Related Topics



Types of sensors

The Norton System Doctor sensors fall into the following general categories:

Memory sensors
Disk sensors
System sensors
Internet/Network sensors
Performance sensors
Information sensors

There are three basic sensor formats:

Graph Sensors
This type provides a real-time display of values. You can select from a number of different graph sensor 

faces, such as analog gauges, bar gauges, histograms, digital counters, or line graphs. The bar, analog, 
and digital formats show current readings only, whereas the histogram and line graphs show several 
measurements collected over a period of time.

You can also display a history window for most sensors. This window displays a large histogram 
detailing current, minimum, and maximum values encountered since the sensor was added or since it 
was last reset.

Stoplight sensors
Sensors that display only as stoplights generally check the system at specified intervals and report the 

results as green, yellow, or red "traffic" signals. For most of these sensors, Norton System Doctor can run 
an appropriate program automatically to correct problems it detects. You can set any sensor to display a 
stoplight face. A red stoplight indicates an alarm condition.

Calendar sensors
The Windows Up Time and Current Date & Time sensors display calendars.

Most sensors can display their information in one of two complementary ways. For example, the Disk 
Space sensor can display the amount of disk space that is currently free or used. The Cache Hits 
sensor can display the percentage of cache hits or misses. You can control the sensor's display from 
the Style tab of the sensor Properties.

{button ,AL(`About sensor history;When to reset a sensor;When to reset Norton System Doctor;When 
to update a sensor;types of memory sensors;types of disk sensors;types of system sensors;types of 
network sensors;types of performance sensors;types of information sensors',0,`',`')}    Related Topics



Types of disk sensors

Norton System Doctor includes many sensors to monitor various disk conditions. To monitor several 
different disks, you can add an individual instance of each sensor. In addition, many of these sensors 
can be set to monitor all drives simultaneously, and trigger an alarm if any one of the drives meets a 
critical condition.

Disk Optimization
Disk Health
Image
Disk Doctor
Disk Slack Space
Disk SMART Status
Disk Space
Disk Doctor Surface Test

{button ,AL(`About sensor alarms;To set the drive to be monitored;Types of sensors',0,`',`')}    Related 
Topics



Types of information sensors

Norton System Doctor includes these sensors that can help you gather information about your system:

Current Date and Time
Norton Protected Files
Norton Utilities LiveUpdate
Windows Up Time

{button ,AL(`About sensor alarms;Types of sensors',0,`',`')}    Related Topics



Types of memory sensors

Norton System Doctor includes a number of sensors related to memory usage. The memory sensors 
let you monitor memory usage in real time. As you open, use, and close applications, you can see the 
effect on memory availability. You can thereby isolate the applications, or the operations within those 
applications, that consume large amounts of memory.

DOS Memory
GDI Resources
Memory Load
Physical Memory
Selectors (16-bit)
Swap File Size
Swap File Utilization
User Resources
Virtual Memory

{button ,AL(`About sensor alarms;Types of sensors',0,`',`')}    Related Topics



Types of Internet and network sensors

Norton System Doctor includes these sensors that can monitor your network connection:

Internet Packet Turnaround
Internet Speedometer
Network Reads Throughput (IPX)
Network Writes Throughput (IPX)

{button ,AL(`About sensor alarms;Types of sensors',0,`',`')}    Related Topics



Types of performance sensors

Norton System Doctor includes sensors that can monitor the performance of your disk cache and 
monitor various Windows performance statistics. The cache sensors can help you fine-tune your 
computer, analyze the performance of its disk cache, and make upgrade decisions. The Windows 
Performance Stats sensors let you use Windows own recordkeeping functions to follow the 
performance of various aspects of your system.

Cache Hits
Cache Memory Utilization
Disk Throughput
Windows Performance Stats

{button ,AL(`About sensor alarms;Types of sensors',0,`',`')}    Related Topics



Types of system sensors

Norton System Doctor includes these sensors that can monitor the performance of your system:

Battery Power
CPU Usage
CrashGuard+
Norton AntiVirus Definitions
Norton AntiVirus SE Scan
Open Files
Rescue Disk
Threads
WinDoctor

{button ,AL(`About sensor alarms;Types of sensors',0,`',`')}    Related Topics



About the Battery Power sensor

This sensor monitors the charge remaining in a portable computer's battery. Over time, this sensor can 
help you get an idea of how your portable consumes power, and how often you need to recharge the 
battery. Always check the charge level before starting an operation that consumes a lot of power (any 
operation that involves long or frequent accesses to a drive).

Before changing the alarm trigger level, consider the type of work you're doing, your previous 
experience with the frequency of recharges, and the age of the battery.

This sensor requires your computer's battery power source to be compliant with Microsoft's Power 
Management API. If your computer does not include a battery that can be used as the power source, 
this sensor displays "AC Power."

{button ,AL(`About sensor alarms;Types of sensors',0,`',`')}    Related Topics



About the Cache Hits sensor

This sensor monitors how much of the data required by applications is found in the disk cache. Every 
"cache hit" indicates requested data was found in the cache. A "cache miss" means the data had to be 
retrieved from the disk. Because the cache is part of RAM, data can be accessed much more quickly 
from the cache than from the hard disk.

If your computer requested data from disk 10,000 times and 7,500 of those times the data was 
available from the cache, the cache hit rate would be 75%. Many computers can achieve a cache hit 
rate of 99%.

A small value for cache hits can indicate one or more of these conditions:

Large number of processes accessing data at the same time
Small disk cache

The size of the disk cache is controlled by Windows itself, and changes dynamically to balance the needs 
of the system with the amount of RAM installed on your computer. Closing non-essential applications can 
make more memory available to the disk cache, as can installing more RAM in the computer.

If you choose to display the cache miss percentage rather than the cache hit percentage, the name of 
this sensor changes to "Cache Misses."

{button ,AL(`About sensor alarms;about the cache memory utilization sensor;about the Disk 
Throughput sensor',0,`',`')}    Related Topics



About the Cache Memory Utilization sensor

This sensor monitors the amount of physical memory (RAM) in use for the disk cache.

The disk cache is a portion of RAM that has been set aside by Windows for use as a temporary holding 
area for data from the disk. Data can be accessed from RAM much more quickly than from disk, so a 
larger disk cache generally results in better computer performance.

Windows controls the size of the disk cache dynamically, balancing the needs of the system with the 
amount of RAM installed on your computer. Closing non-essential applications can make more 
memory available for the disk cache, as can installing more RAM in the computer.

The sensor's measurement can be expressed in megabytes, kilobytes, bytes, or as a percentage of the 
maximum cache size the sensor has recorded for your computer. You can also open System 
Information from this sensor's context menu to see more details about current memory usage.

{button ,AL(`About sensor alarms;Types of sensors;Introducing System Information;about the Disk 
Throughput sensor;about the cache hits sensor',0,`',`')}    Related Topics



About the Disk Throughput sensor

This sensor measures how quickly your computer handles requests for data stored on disk. Because 
some of this data will be pre-loaded into the disk cache, the measurement is influenced by both the 
speed of the system RAM and the speed of disk accesses.

A low disk throughput reading can indicate one or more of these conditions:

Large number of processes accessing data at the same time
Small disk cache

The size of the disk cache is controlled by Windows itself, and changes dynamically to balance the needs 
of the system with the amount of RAM installed on your computer. The only way to increase the size of 
the disk cache is to install more RAM.

Highly fragmented data on the disk
Slow disk drive

{button ,AL(`About sensor alarms;About sensor maximum readings;About the Cache Memory 
Utilization sensor;About the cache hits sensor',0,`',`')}    Related Topics



About the CPU Usage sensor

This sensor measures how much time your computer's CPU spends executing instructions versus the 
time it spends idle.

If the CPU usage is always high, an application or other process may be using resources inefficiently, 
or you may have too many applications running simultaneously. This sensor can help you monitor your 
computer's performance, troubleshoot problems, and analyze the performance of particular 
applications and processes.

It is fairly common for the CPU usage to jump to 100% during some operations, such as loading 
programs and some CPU-intensive CAD and spreadsheet operations. Also note that using Windows' 
Advanced Power Management feature or certain 16-bit device drivers loaded from CONFIG.SYS or 
AUTOEXEC.BAT can prevent the CPU usage from ever falling to a low value. 

You can configure this sensor to display the percentage of time that the CPU is either used or free. You 
can also open System Information from this sensor's context menu to get additional information about 
the CPU or to benchmark the system.

{button ,AL(`About sensor alarms;To disable Advanced Power Management;Introducing System 
Information;Types of sensors',0,`',`')}    Related Topics



About the Current Date and Time sensor

This sensor shows the current date and time. It can provide a convenient reference, especially if 
Norton System Doctor is configured to remain on top of other windows.

This sensor always shows a calendar format. You can change the font that this sensor and the 
Windows Up Time sensor use to display the date.

{button ,AL(`Types of sensors;To create display schemes;To keep Norton System Doctor visible at all 
times',0,`',`')}    Related Topics



About the Disk Optimization sensor

This sensor monitors the level of disk fragmentation. It can alert you or automatically run Speed Disk to 
defragment and optimize the disk whenever fragmentation of the used disk space exceeds a critical 
level.

Fragmentation. can impair your computer's performance by slowing access to the disk. The more you 
create, modify, copy, or delete files, the more quickly the disk becomes fragmented.

From this sensor's Properties, you can configure the sensor to show the percentage of used disk 
space that is unfragmented, rather than fragmented. You can also control how frequently the sensor 
scans a disk, and which disk it scans. You can add a separate Disk Optimization sensor for any drive, 
or have a single sensor watch all local drives.

By default, Norton System Doctor displays a Disk Optimization sensor for every local hard drive, and 
appropriate alarm trigger levels are chosen automatically. In addition to hard disks, this sensor can 
monitor high-capacity, removable media, such as Iomega's Zip  and Jaz

 drives.
The Disk Optimization and Disk Doctor sensors both scan your drives. Norton System Doctor can 

gather the information required by both sensors from a single scan. If you change the scan or rescan 
intervals for a disk from one sensor's Properties, the intervals for the other sensor are automatically 
adjusted to match.

{button ,AL(`About sensor alarms;Types of disk sensors;About the Disk Doctor sensor;Introducing 
Speed Disk',0,`',`')}    Related Topics



About the Image sensor

This sensor monitors how recently a disk was imaged, and can alert you or run Image automatically 
after a specified amount of time has elapsed.

Image takes a "snapshot" of critical disk information for a local disk drive. This information, the disk 
"image," can be used to unformat a disk and can help to unerase files or folders. Run Image frequently 
to keep the image information current. A red light on the sensor indicates that the time period specified 
by the sensor's alarm properties has expired, and it is time to run Image again.

In addition to hard disks, this sensor can monitor high-capacity, removable media, such as 
Iomega's Zip
 and Jaz
 drives.

From the Drive tab of this sensor's Properties you can control how frequently the sensor scans a disk 
and which disk it scans. You can add a separate Image sensor for any drive, or have a single sensor 
monitor all local hard drives with non-removable media. (You should not set multiple Image sensors to 
Monitor All Local Hard Drives.)

Before changing the trigger level of this sensor, consider the type of work you're doing. The more you 
create, modify, copy, or delete files, the more frequently you should run Image.

{button ,AL(`Introducing Image;About sensor alarms;Types of disk sensors',0,`',`')}    Related Topics



About the Disk Doctor sensor

This sensor monitors the logical structures on a local disk drive. It can alert you or automatically run 
Norton Disk Doctor if problems are detected. In addition to hard disks, this sensor can monitor high-
capacity, removable media, such as Iomega's Zip  and Jaz

 drives.
The sensor periodically scans the disk checking for file allocation table errors, cross-linked files, and lost 
clusters. A red light means significant problems exist, a yellow light means only lost clusters are detected, 
and a green light means no problems have been detected.

This sensor does not check the disk surface, the boot sector, or the partition table. However, if 
problems are detected, Norton Disk Doctor will perform a complete disk diagnosis, and can repair most 
problems it detects. (The Disk Doctor Surface Test sensor periodically scans the disk surface for 
errors.)

From the Drive tab of this sensor's Properties you can control how frequently the sensor scans a disk 
and which disk it scans. You can add a separate Disk Doctor sensor for any drive, or have a single 
sensor watch all local drives with non-removable media. (You should not set multiple Disk Doctor 
sensors to Monitor All Local Hard Drives.) You can also specify how long the sensor should wait before 
rescanning if the scan is interrupted because of other system activity.

The Disk Doctor and Disk Optimization sensors both scan your drives. Norton System Doctor can 
gather the information required by both sensors from a single scan. If you change the scan or rescan 
intervals for a disk from one sensor's Properties, the intervals for the other sensor are automatically 
adjusted to match.

{button ,AL(`Introducing Norton Disk Doctor;About sensor alarms;About the Disk Doctor Surface Test 
sensor;About the Disk Optimization sensor;Types of disk sensors',0,`',`')}    Related Topics



About the Disk Slack Space sensor

This sensor shows the amount of slack space on a disk.

The operating system allocates (reserves) space for files in discrete chunks called clusters. Most files, 
however, occupy less physical space on the disk than the operating system has reserved. Slack is the 
excess space allocated for a file leftover space in the last cluster of a file that remains unoccupied by 
file data. Once a cluster has been allocated to a particular file, it cannot be used for any other purpose, 
so the slack space is essentially wasted space.

The FAT32 file system uses smaller cluster sizes to help minimize disk slack space.

{button ,AL(`Types of disk sensors;About the Disk Space sensor',0,`',`')}    Related Topics



About the Disk SMART Status sensor

This sensor warns you of imminent disk hardware failures, allowing you time to back up files and 
replace the disk drive before losing valuable data.

Self-Monitoring, Analysis, and Reporting Technology (SMART) is built in to newer IDE hard drives. It 
allows these drives to monitor their own operation and predict most drive hardware failures before they 
occur. The Disk SMART sensor works together with SMART drives to alert you to these conditions.

This sensor only supports drives that have SMART built in.

{button ,AL(`About the Disk Doctor sensor',0,`',`')}    Related Topics



About the Disk Space sensor

This sensor monitors the free space on local or network hard disks. The sensor can help you anticipate 
low disk space conditions so you don't run out of disk space while running applications, creating, or 
copying files. From this sensor's context menu you can open System Information to get additional 
details about the disks and disk usage.

In addition to hard disks, this sensor can monitor high-capacity, removable media, such as 
Iomega's Zip
 and Jaz
 drives. If you're a network administrator, you can use Disk Space sensors to track usage of network 

drives.

Before changing the alarm's trigger level, consider the type of work you're doing and the amount of 
disk space currently available. For example, multimedia and graphics applications, large databases, 
and working with large documents can consume large amounts of disk space quickly.

From the Drive tab of this sensor's Properties you can control how frequently the sensor scans a disk 
and which disk it scans. You can add a separate Disk Space sensor for any drive. You can also 
configure the sensor to display the amount of used, rather than free disk space.

{button ,AL(`About sensor alarms;Introducing System Information;Types of disk sensors;About the Disk 
Slack Space sensor',0,`',`')}    Related Topics



About the Disk Doctor Surface Test sensor

This sensor periodically scans the surface of a local (non-network) hard disk. It can alert you or 
automatically run Norton Disk Doctor if a surface problem is detected. The bar on the sensor face 
indicates the progress of the current surface scan. The Disk Doctor Surface Test sensor can help you 
prevent problems that would result from disk failures.

The Surface Test sensor scans during CPU idle time to minimize the effects on system 
responsiveness. After other system activity interrupts a scan, the sensor later resumes scanning at the 
location where the interruption occurred.

From the Drive tab of this sensor's Properties, you can control how frequently the sensor scans a disk 
and which disk it scans. You can add a separate Disk Doctor Surface Test sensor for any drive, or have 
a single sensor watch all local drives with non-removable media. (You should not set multiple Surface 
Test sensors to Monitor All Local Hard Drives.) You can also specify how long the sensor should wait 
before rescanning if the scan is interrupted because of other system activity.

In addition to hard disks, this sensor can monitor high-capacity, removable media, such as 
Iomega's Zip
 and Jaz
 drives. Network administrators can use Surface Test sensors to track usage of network drives. The 

Surface Test sensor cannot monitor floppy disks.

{button ,AL(`Introducing Norton Disk Doctor;About sensor alarms;Types of disk sensors;About the Disk 
Doctor sensor',0,`',`')}    Related Topics



About the DOS Memory sensor

This sensor monitors the availability of conventional memory on your computer.

Windows loads any real-mode, DOS-based device drivers into the DOS memory region. The 
CONFIG.SYS and AUTOEXEC.BAT files specify the real-mode drivers to be loaded. Some 
applications designed to run under Windows 3.x also must use the DOS memory region, and real-
mode drivers reduce the amount of memory available to such applications.

Note that "DOS memory" is not the same thing as the memory that is available when you use Windows 
to open a DOS window. Some older 16-bit programs can use only DOS memory. This sensor reports 
the amount of memory available for these programs.

Windows replaces most real-mode drivers with new virtual device drivers, so your system may 
not use any real-mode drivers. The CONFIG.SYS and AUTOEXEC.BAT files are necessary only if you 
need to load real-mode drivers or set parameters for DOS windows, such as the look of the DOS prompt.

{button ,AL(`About sensor alarms;Types of memory sensors',0,`',`')}    Related Topics



About the GDI Resources sensor

This sensor measures the usage of Windows Graphics Device Interface (GDI) memory resources.

To run applications, Windows requires free GDI memory resources, USER resources, and (for 
Windows 3.x applications) selectors. Low levels of these resources can prevent you from running 
programs, and will cause Windows out-of-memory errors. When GDI resources are low, you should 
close any unnecessary applications to free up some memory.

Compared to Windows 3.x, later versions of Windows greatly expand and enhance GDI resources, in 
part by providing some of the most memory-intensive operating system operations through new, 32-bit 
code. For example, spooling, printing, font-drawing, and many graphics operations now use 32-bit 
code.

However, some GDI resources continue to be provided through the older, 16-bit code. Although this 
older code ensures compatibility for applications designed to run under Windows 3.x, it also retains a 
number of the limitations of the older operating system. Because every window and dialog box that 
gets displayed requires GDI resources, they are still somewhat limited, especially if you run many 16-
bit applications.

From this sensor's context menu you can open System Information to get details about your 
computer's memory usage.

{button ,AL(`About sensor alarms;Introducing System Information;About the User Resources 
sensor;About the Selectors (16-bit) sensor;Types of memory sensors',0,`',`')}    Related Topics



About the Internet Packet Turnaround sensor

This sensor shows the speed of Internet packet transmission between your computer and an Internet 
site of your choice. The sensor sends a signal to the Internet site, and notes how long it takes to 
receive a response. A lower millisecond value for this sensor, means a faster turnaround time, and 
faster communication between this computer and the selected site.

If you enable this sensor's alarm, it will notify you when Internet communications between this 
computer and the specified site are acceptably fast.

You can specify the Internet site (host name or IP address) that this sensor monitors. Use the Site tab 
of the sensor's Properties. To monitor more than one site, add multiple Internet Packet Turnaround 
sensors.



About the Internet Speedometer sensor

This sensor shows the speed of your Internet connection to the host site of your choice. The sensor 
sends a signal to the Internet site, and notes how long it takes to receive a response. A higher 
millisecond value for this sensor, means slower Internet response time between this computer and the 
selected site.

This sensor's alarm can notify you when transmission speeds to the site become unacceptably slow.

You can specify the Internet site (host name or IP address) that this sensor monitors. Use the Site tab 
of the sensor's Properties. To monitor more than one site, add multiple Internet Speedometer sensors.



About the Memory Load sensor

This sensor reports computer memory usage by monitoring how much of the memory has been 
committed to running applications.

When all the physical memory (RAM) has been committed, Windows can continue to open applications 
by committing virtual memory from the swap file. However, applications run faster when they are 
entirely resident in RAM, rather than partially "swapped out" to disk-based virtual memory.

When the sensor reports a 50% memory load, all RAM has been committed. Subsequent memory 
commitment requires swapping data between RAM and virtual memory, which can slow computer 
operations.

When this sensor indicates a high memory load, you should try to close some applications.

{button ,AL(`About sensor alarms;Introducing System Information;Types of memory sensors',0,`',`')}    
Related Topics



About the Network Reads Throughput (IPX) sensor

This sensor measures the speed at which your system reads data from a Novell NetWare network. The 
sensor can help you evaluate the performance of your network card and other network hardware.

From this sensor's context menu you can open System Information to get additional network 
information.

{button ,AL(`About sensor alarms;About sensor maximum readings;Introducing System 
Information;Norton System Doctor notes for network administrators;Types of sensors',0,`',`')}    Related 
Topics



About the Network Writes Throughput (IPX) sensor

This sensor measures the speed with which your system writes data to a Novell NetWare network 
drive. The sensor can help you evaluate the performance of your network card and other network 
hardware.

From this sensor's context menu you can open System Information to get additional network 
information.

{button ,AL(`About sensor alarms;About sensor maximum readings;Introducing System 
Information;Norton System Doctor notes for network administrators;Types of sensors',0,`',`')}    Related 
Topics



About the Norton Protected Files sensor

This sensor shows the number of files currently under Norton Protection. Norton Protection enhances 
the file recovery capabilities offered by the Windows Recycle Bin. Norton Protection lets you recover 
overwritten files, files deleted from a DOS window, and files deleted by Windows applications. As long 
as these files are protected, they can be recovered intact, even after their deletion.

Every time you change a file and save the changes, the older version of the file is overwritten, 
and lost forever. The standard Windows Recycle Bin cannot recover these files, because they were not 
deleted; they were only modified. By keeping Norton Protection enabled, you can recover these earlier 
versions of overwritten files.



About the Norton Utilities LiveUpdate sensor

This sensor periodically displays an alarm message reminding you to check for updates to Norton 
Utilities. If your computer is connected to a modem or to the Internet, this sensor can use Symantec's 
LiveUpdate technology to get Norton Utilities updates automatically when they become available.

{button ,AL(`About LiveUpdate',0,`',`')}    Related Topics



About the Open Files sensor

This sensor monitors the number of files that are currently open on a local or network hard disk. 
Windows applications and processes open files during normal execution. Windows imposes no limit to 
the number of files that can be open simultaneously. However, a large number of open files can 
degrade system performance.

This sensor can help you analyze the performance of your computer as well as of particular 
applications (especially database applications, since they often open many files). A large number of 
open files might explain, for example, poor disk cache performance.

To monitor open files on several disks, add a separate sensor for each.

{button ,AL(`About sensor alarms;About sensor maximum readings;Types of disk sensors',0,`',`')}    
Related Topics



About the Physical Memory sensor

This sensor monitors usage of your computer's physical memory (RAM). Applications run faster when 
they are using physical rather than virtual memory.

Windows uses much of the available RAM as a disk cache, so this sensor generally shows only a small 
amount of RAM free. Windows changes the size of the cache dynamically, however, freeing up RAM 
as needed for other applications.

From this sensor's context menu, you can open System Information to get more details about 
your computer's current memory usage.

{button ,AL(`About sensor alarms;Introducing System Information;Types of memory sensors',0,`',`')}    
Related Topics



About Windows Performance Stats sensors

These sensors show the various performance statistics monitored by Windows itself. The sensors 
provide the same information reported by the Windows System Monitor program. You can add multiple 
sensors to monitor different types of performance data, and view them all together with your other 
Norton System Doctor sensors. Though some of this information duplicates native System Doctor 
sensors, Windows Performance Stats sensors do not include sensor alarms.

At minimum, this sensor provides access to three categories of performance statistics:

File System
Measurements of reading and writing operations

Kernel
Number of virtual machines that are running, number of threads that are running, and processor usage 

percentage
Memory Manager

Measurements relating to the Windows swap file and virtual memory management

Depending upon your system, additional categories such as "network" may also be available.

The Items To Monitor tab of this sensor's Properties lists each category of information available, the 
performance items in each category, and a description of each. It also displays the item titles for the 
large and small style sensors. You can change these titles, if you want.

You can add several Windows Performance Stats sensors to monitor different types of 
information.

{button ,AL(`Norton System Doctor notes for network administrators;Types of sensors',0,`',`')}    Related 
Topics



About the Rescue Disk sensor

This sensor periodically checks your system's critical setup data and startup files. The sensor alerts 
you when any of these files has changed, and detects whether any new files should be added to your 
rescue disk set.

A rescue disk set stores copies of these important files on removable media. The rescue disk set is 
unique to your computer. If your computer fails to start, you can use your rescue disk set to get the 
computer running again. Once the computer has been started, Norton Utilities can help fix any 
problems, and restore your computer to full functioning.

If your system has an Iomega Zip
 or Jaz
 drive, you can create a Norton Zip Rescue set. If problems prevent your computer from starting 

normally, this type of rescue set can be used to boot the computer to Windows. In this case, the Rescue 
Recovery Wizard starts automatically during the rescue to help get your system running properly again.

It is vital that the information on your rescue disks be kept current. The Rescue Disk sensor can help 
ensure that the information is up to date by alerting you or automatically running Rescue Disk to 
update the information whenever necessary.

Because computers with Zip drives can create both basic and Norton Zip rescue disk sets, the 
Rescue Disk sensor tracks information for only the last type of rescue disk set you created or updated. 
You should not add multiple Rescue Disk sensors to the Norton System Doctor sensor panel.

{button ,AL(`About sensor alarms;Types of sensors;Introducing Rescue Disk',0,`',`')}    Related Topics



About the Selectors (16-bit) sensor

This sensor reports on the usage of selectors, which 16-bit applications and processes require for 
memory management.

A total of 8192 selectors are available under Windows. Some applications use hundreds of selectors. 
When no selectors are available, out of memory errors result, and you cannot open more 16-bit 
applications. When the alarm is triggered, you should close any unnecessary applications.

Because they manage memory in a fundamentally different way, 32-bit applications do not consume 
selectors.

{button ,AL(`About sensor alarms;About the GDI Resources sensor;About the User Resources 
sensor;Types of memory sensors',0,`',`')}    Related Topics



About the Swap File Size sensor

This sensor shows the amount of disk space currently reserved for use by the Windows swap file. By 
default, Windows dynamically enlarges and reduces this space according to the demands of the 
system.

The sensor can display the swap file size in megabytes, kilobytes, bytes, or as a percentage of 
available free disk space. From this sensor's context menu you can open System Information to get 
more details about your computer's current memory usage.

You can designate that a different drive be used for the swap file, or specify the swap file 
minimum and maximum sizes. To do so, choose Properties from the context menu of My Computer, click 
the Performance tab, and then click Virtual Memory.

{button ,AL(`About the Swap File Utilization sensor;About the Virtual Memory sensor;About sensor 
alarms;Types of memory sensors',0,`',`')}    Related Topics



About the Swap File Utilization sensor

This sensor shows how much of the space reserved for the Windows swap file is currently in use for 
temporary data storage. The swap file is used by Windows to manage virtual memory. By default, 
Windows continuously adjusts the space reserved for the swap file, according to the demands of the 
system. This sensor shows you how efficiently those demands are being met.

Applications run faster when they are entirely resident in RAM, rather than partially "swapped out" to 
virtual memory. However the virtual memory provided by the swap file enables your computer to run 
more programs simultaneously than the installed physical memory (RAM) would otherwise allow. 
Swapping data to the disk also allows the computer to run larger programs.

The sensor can display swap file utilization in megabytes, kilobytes, bytes, or as a percentage of the 
total space reserved for the swap file. You can also use this sensor's context menu to open System 
Information to get more details about your computer's current memory usage.

You can designate that a different drive be used for the swap file, or control the swap file 
minimum and maximum sizes. To do so, choose Properties from the context menu of My Computer, click 
the Performance tab, and then click Virtual Memory.

{button ,AL(`About the Swap File sensor;About the Virtual Memory sensor;About sensor alarms;Types 
of memory sensors',0,`',`')}    Related Topics



=======================================================



About the Threads sensor

This sensor monitors the number of threads that are currently running on your computer.

The 32-bit portions of the operating system and other 32-bit applications, can break their execution into 
separate tasks or "threads." This ability takes maximum advantage of the CPU's available resources, 
because multi-threaded applications can be faster and more responsive. For example, a multi-threaded 
application can give you the option of canceling a long operation (such as opening a large document) 
or switching to another task while the operation is under way. Multi-threaded applications can also 
create one thread for a high-priority operation (such as responding to keyboard or mouse input) and 
lower-priority threads for background operations (such as repaginating a document or preparing it for 
printing). However, having too many threads running concurrently can waste memory and degrade 
system performance.

The Threads sensor can help you analyze the performance of your computer and evaluate how 
effectively 32-bit applications use multi-threading. Before changing the alarm trigger level for this 
sensor, determine an appropriate level by considering the type of work you're doing and the amount of 
memory typically available. For example, if you have a number of 32-bit applications open at one time, 
your normal threads usage can be quite high.

{button ,AL(`About sensor alarms;About sensor maximum readings;Introducing System 
Information;Types of memory sensors',0,`',`')}    Related Topics



About the USER Resources sensor

This sensor measures the usage of Windows USER resources.

In order to run applications, Windows requires free USER memory resources, GDI resources, and (for 
Windows 3.x applications) selectors. When these resources are exhausted, additional applications 
cannot be opened, and you receive out-of-memory errors. When USER resources are low, you should 
close any unnecessary applications to free up some memory.

Compared to Windows 3.x, later versions of Windows increase the availability of USER resources, in 
part by providing some of those resources through new, 32-bit code. However, many USER resources 
continue to be provided through the older, 16-bit code. Although this older code ensures compatibility 
for applications designed to run under Windows 3.x, it also retains a number of the limitations of the 
older operating system. Because every window and dialog box that gets displayed requires USER 
resources, they are still somewhat limited, especially if you run many 16-bit applications.

From this sensor's context menu you can open System Information to get details about your 
computer's memory usage.

{button ,AL(`About sensor alarms;Introducing System Information;About the GDI Resources 
sensor;About the Selectors (16-bit) sensor;Types of memory sensors',0,`',`')}    Related Topics



About the Virtual Memory sensor

This sensor reports the amount of disk space available for use as virtual memory. Potential virtual 
memory includes any free space on the disk, plus the space in the swap file that is not currently in use 
for temporary data storage.

Virtual memory enables your computer to run more applications simultaneously than the installed 
physical memory (RAM) would otherwise allow. Swapping data from RAM to the disk also allows the 
computer to run larger applications. When virtual memory gets low, computer performance 
deteriorates, running applications may not work properly, and you may not be able to start any new 
applications. This sensor can help you optimize your computer's performance and make upgrade 
decisions.

When potential virtual memory space is low, you can increase it by making more space available on 
the disk containing the swap file, or moving the swap file to another local hard disk that has more 
space available. Space Wizard helps you free up space on a disk by finding unnecessary files and 
optionally deleting, moving, or compressing them.

By default, the sensor shows the megabytes available for virtual memory. You can optionally set the 
sensor scale to other units. You can also configure this sensor to show the amount of virtual memory 
currently in use for temporary data storage, rather than the amount available.

From this sensor's context menu, you can open System Information to get details about your 
computer's memory usage.

{button ,AL(`About the Swap File sensor;About the Swap File Utilization sensor;About sensor 
alarms;Introducing System Information;Types of memory sensors',0,`',`')}    Related Topics



About the Norton AntiVirus Definitions sensor

This sensor shows whether your virus definitions files are current. It is critical to have up-to-date virus 
definitions files so the Norton AntiVirus SE Scan sensor can identify new viruses. When the definitions 
become old, the stoplight turns red. The alarm message reminds you to update your virus definitions 
files.

If your computer is connected to a modem or to the Internet, this sensor can use Symantec's 
LiveUpdate technology to get new virus definitions when they become available. Updated virus 
definitions files are made available periodically from Symantec Corporation, and can also be 
downloaded from Symantec's World Wide Web site (http://www.symantec.com), from many computer 
bulletin boards, or can be mailed to you directly from Symantec Corporation.

A red stoplight does not mean your system is infected with a virus; it means your virus definitions 
files are getting old. This sensor will only turn green when the virus definitions on your machine are 
younger than the age set on the Alarm tab of this sensor's Properties.

{button ,AL(`About LiveUpdate;About the Norton AntiVirus SE Scan sensor;About computer 
viruses;What computer viruses can and cannot do;Types of computer viruses;The computer virus life 
cycle;to specify files to be scanned for viruses',0,`',`')}    Related Topics



About the Norton AntiVirus SE Scan sensor

This sensor uses advanced antivirus technology to periodically scan your system for computer viruses. 
Norton AntiVirus SE (starter edition) is built into Norton Utilities. It can repair most viruses that are 
detected. The sensor's stoplight face turns red whenever a virus is found, and the sensor can alert you 
with an alarm message, or automatically initiate repairs.

To prevent or minimize the damage that viruses can cause, allow this sensor to scan your system 
frequently.

From this sensor's Properties, you can customize the scanning behavior. From the Files To Scan tab, 
you can specify the types of files that should be scanned. From the Drive tab you can control how 
frequently the sensor scans a disk and which disk it scans. You can add a separate Norton AntiVirus 
SE Scan sensor for any drive, or have a single sensor check all local drives.

    You should not have multiple Norton AntiVirus SE sensors set to Monitor All Local Hard Drives.
For even better virus protection, get the full version of Norton AntiVirus. Norton AntiVirus 4.0 

includes Auto-Protect and Bloodhound-Macro heuristic technology to continuously keep your computer 
protected from viruses.

Auto-Protect monitors your system continually as you work, watching file operations as they 
happen, and alerting you to viruses or virus-like activities. Bloodhound-Macro heuristic technology helps 
stop macro viruses even unknown new strains
before they strike.

{button ,AL(`About the Norton AntiVirus Definitions sensor;About computer viruses;What computer 
viruses can and cannot do;Types of computer viruses;The computer virus life cycle;to specify files to 
be scanned for viruses',0,`',`')}    Related Topics



About computer viruses

A computer virus is a self-replicating program, written intentionally to alter the way your computer 
operates without your knowledge or permission. Computer viruses are designed to attach themselves 
to other program files, and become activated when those programs are run. While active, a virus 
replicates by copying itself to other programs on any available disk.

Viruses exist in two forms:

Active in your computer’s memory
Lying dormant in files and boot records

Some computer viruses damage the data on your disks by corrupting programs, deleting files, or even 
reformatting the disk.

Just like the effects of biological viruses, effects of computer viruses may be undetectable for days or 
weeks. Some viruses are timed to cause their damage at certain hours of the day or on certain dates. 
Before a virus does any noticeable damage to your system, an infected hard disk can infect disks you 
insert into your computer’s floppy disk drive. Once infected, those floppy disks can infect other 
computers that read them. And thus the infection can spread before any damage is done.

Powering off the computer removes viruses from the memory, but not from disks or files that have been 
infected. The next time you use your computer, the virus is activated again and attaches itself to more 
programs.

There are ways to protect your computer from viruses:

Use the Norton AntiVirus SE Scan sensor to periodically scan your computer for viruses as you 
work.

Use the Norton AntiVirus Definitions sensor to keep your virus definitions up to date. This ensures 
that your computer is protected against newly discovered viruses.

Purchase and use a good virus detection and removal program, such as Norton AntiVirus.
Make periodic backups of your hard disk.
Buy and use only legal copies of all software you use and make write-protected backup disks.
Keep an updated, write-protected set of rescue disks available to help you recover your system if 

you’re attacked by a virus.

{button ,AL(`About the Norton AntiVirus SE Scan sensor;About the Norton AntiVirus Definitions 
sensor;What computer viruses can and cannot do;Types of computer viruses;The computer virus life 
cycle;Introducing Rescue Disk',0,`',`')}    Related Topics



What computer viruses can and cannot do

Viruses can:

Infect program files used for word processing, spreadsheet, or operating system programs and 
document files (such as .DOT and .DOC files) that contain macros.

Infect the information stored on disks by attaching to special programs in areas called boot 
records and master boot records.

Corrupt files and data.

Viruses cannot:

Damage hardware, such as keyboards or monitors, although strange behavior, such as screen 
distortion or characters not appearing when typed, may occur. If this happens, a virus has affected the 
programs that control the display or keyboard.

Damage your disks physically.
Infect write-protected disks.

{button ,AL(`About the Norton AntiVirus SE Scan sensor;About the Norton AntiVirus Definitions 
sensor;About computer viruses;Types of computer viruses;The computer virus life cycle',0,`',`')}    
Related Topics



Types of computer viruses

The Norton AntiVirus SE Scan sensor detects all of the following types of viruses:

Program viruses
Viruses that can infect program files, such as applications, or operating system programs. 

Boot viruses
Viruses that can infect boot records or master boot records on disks. When your computer starts, it runs 

specific boot record programs to ready itself for work. Data disks can contain boot viruses too. A virus 
activates when your computer attempts to start from the infected disk. A virus can activate even if your 
computer can’t start up from the infected disk. All boot viruses remain active in memory while your 
computer is on. While in memory, they continue to spread by infecting floppy disks accessed by your 
computer.

Macro viruses
Macros are computer programs that are easily created to repeat a series of actions you do frequently 

using applications like Microsoft Word. Rather than repeating the actions over and over, these 
applications can record the actions as a "macro," and rerun the macro whenever you want.
Macro viruses are written to infect files you create with applications that support macros. These viruses 
can be inadvertently spread to any file you subsequently save using those applications because, in 
applications like Microsoft Word, you can have a macro run automatically whenever Word is started.

{button ,AL(`About the Norton AntiVirus SE Scan sensor;About the Norton AntiVirus Definitions 
sensor;About computer viruses;What computer viruses can and cannot do;The computer virus life 
cycle',0,`',`')}    Related Topics



The computer virus life cycle

The computer virus has a three-stage life cycle: infection, detection, and recovery.

In the infection stage, a virus infects a file in your computer. Typically, infections comes from a variety 
of sources:

Reused floppy disks from unknown sources
Floppy disks from home, school, or friends
Programs downloaded from the Internet or a BBS
Opened, re-shrink-wrapped, or pirated software
Preformatted floppy disks

Your computer can be infected when you boot from an infected disk, reboot with an infected floppy disk 
left in the drive, or run an infected program. The virus spreads when you share the disk or infected 
program or log on to a network.

In the detection stage, the virus is identified and isolated. You may notice that your computer is 
behaving strangely or that files are missing or programs are not working. If you are running Norton 
System Doctor, the virus can usually be identified by the Norton AntiVirus SE Scan sensor before 
damage is done and tell you what files are affected.

In the recovery stage, the virus is eliminated by a virus removal program, like Norton AntiVirus. Unless 
the virus is eliminated, it will continue to infect other files and possibly damage data on your disks. 
Once you have eliminated the virus, you can clean up your computer by re-installing programs from 
master disks or restore files from an uninfected backup. After restoring the programs and data you lost, 
we recommend you do the following:

Rescan all files to find possible sources of infection, before you run any other programs.
Scan all floppy disks to find possible sources of infection.
Discard backups that may be infected.
Keep Norton System Doctor running, with the Norton AntiVirus SE Scan and the Norton Utilities 

LiveUpdate sensors active.

{button ,AL(`About the Norton AntiVirus SE Scan sensor;About the Norton AntiVirus Definitions 
sensor;About computer viruses;What computer viruses can and cannot do;Types of computer 
viruses',0,`',`')}    Related Topics



About the Windows Up Time sensor

This sensor shows the time that has elapsed since Windows was last started. This information can be 
helpful:

If you share a computer
If you experience a power outage
When you are troubleshooting a system
(for example, if a computer frequently needs rebooting)
When you are trying to optimize system performance
(for example, if you want to see if there is a correlation between how long a computer has been 

running and when it runs out of memory or other resources)
If your organization has a policy requiring users to power off their computers at the end of the day 

or over the weekend

This sensor always displays in calendar format, showing the days, hours, minutes, and seconds since 
Windows was last started. You can change the display font for this sensor and the Current Date and 
Time sensor.

{button ,AL(`Types of sensors;To create display schemes',0,`',`')}    Related Topics



About sensor history

Most Norton System Doctor sensors include a history window that provides information about sensor 
readings over time. The Windows Registry stores each sensor's highest and lowest readings and other 
measurement information, so this information will persist even when Norton System Doctor and the 
computer are shut down. You can reset a sensor at any time, causing Norton System Doctor to delete 
its history information from the Registry.

Some sensors
Current Date And Time, Windows Uptime, and the stoplight sensors
have no need for a history window.

{button ,AL(`To display sensor history;When to reset a sensor;When to reset Norton System 
Doctor;types of sensors',0,`',`')}    Related Topics



About the links to other Norton Utilities programs

Some Norton System Doctor sensors can automatically open the appropriate Norton Utilities program 
and correct a detected problem or condition. For example, when a disk becomes fragmented by more 
than a certain percentage, the Disk Optimization sensor can automatically open Speed Disk to 
defragment the disk.

Many sensors include a particular Norton Utilities program on their context (right-click) menus. For 
example, you can choose Open Image from the context menu of the Image sensor. If you choose 
Open System Information from the context menu of a memory-related sensor, System Information 
opens directly to the Memory tab. Drive-related sensors open System Information to the Drive tab.

In addition, the Norton System Doctor menu bar and all sensors' context menus include a Utilities item 
from which you can start other Norton Utilities programs.

{button ,AL(`About sensor alarms;To open Norton Utilities programs from Norton System 
Doctor;introducing System Information',0,`',`')}    Related Topics



When to hide sensors

You may not need to know about the current reading of a particular sensor unless it reaches the level 
you've defined as the alarm level. Or you may be interested only in the long-term statistics about the 
readings for a particular sensor. These are two cases where you might want to hide a sensor.

Hiding a sensor simply prevents it from appearing in the Norton System Doctor window. A hidden 
sensor continues to run, maintains the measurement information available in the history window, and 
can still alert you to an alarm condition.

If you have an alarm set for a hidden sensor, be sure you don't set the alarm properties to No 
Action, or you won't know when the alarm condition occurs.

{button ,AL(`About sensor alarms;To hide and show sensors',0,`',`')}    Related Topics



When to reset a sensor

Most sensors maintain history information about their readings from one Windows session to the next. 
The highest and lowest readings recorded appear in a sensor's history window.

You can reset a sensor's highest and lowest readings to zero at any time by clicking the sensor's Reset 
command. For example, if you want to monitor CPU usage while a particular application is running, you 
can set up the CPU Usage sensor, use its Reset command, and then open the application of interest.

By keeping a second instance of the same sensor active and not resetting it, you can 
simultaneously monitor the cumulative highest and lowest readings as well.

Sensors that have no history information to maintain such as Current Date And Time and Rescue Disk 

have no Reset command.
You can reset a sensor's Properties to the defaults by clicking Default on the various Properties 

dialog box tabs.

{button ,AL(`About sensor history;To reset Norton System Doctor sensors;When to reset Norton 
System Doctor',0,`',`')}    Related Topics



When to reset Norton System Doctor

You can reset all Norton System Doctor settings to their defaults at any time. Doing so causes only the 
default sensors to be active, gives those sensors their default properties, resets their history 
information to zero, and returns the Norton System Doctor window to its default appearance. Using this 
global reset feature is convenient if you want to return Norton System Doctor to a known state quickly.

{button ,AL(`About sensor history;To reset Norton System Doctor sensors;when to reset a 
sensor',0,`',`')}    Related Topics



When to update a sensor

The Update command causes the sensor to update its reading immediately, rather than waiting the 
normal amount of time between updates. For example, if you are concerned that a particular disk may 
have developed a problem and the Disk Doctor sensor is supposed to perform a disk scan only every 
hour, you can choose Update from the Disk Doctor sensor's context menu to perform the scan now.

Choose Update from the sensor context (right-click) menu to update a sensor.

{button ,AL(`To update sensor readings',0,`',`')}    Related Topics



Customizing Norton System Doctor

While Norton System Doctor can do its work with little or no attention from you, it also gives you the 
option of customizing its appearance and behavior.

You can customize Norton System Doctor in any of these ways:

{button ,JI(`SYSDOC32.HLP>task',`SYSDOC_TASK_TO_ACTIVATE_SENSOR')}    Add or remove 
sensors

{button ,JI(`SYSDOC32.HLP>task',`SYSDOC_TASK_TO_ARRANGE_SENSORS')}    Change 
sensor positions

{button ,JI(`SYSDOC32.HLP>task',`SYSDOC_TASK_TO_SET_SENSOR_SIZE')}    Change sensor 
sizes

{button ,JI(`SYSDOC32.HLP>task',`SYSDOC_TASK_TO_SET_SENSOR_ALARM')}    Control 
alarm behavior

{button ,JI(`SYSDOC32.HLP>task',`SYSDOC_TASK_TO_DISPLAY_TITLE_BAR')}    Control the 
display of the title, menu, and Symantec logo bars

{button ,JI(`SYSDOC32.HLP>task',`SYSDOC_TASK_CREATE_DISPLAY_SCHEME')}    Create 
custom display schemes

{button ,JI(`SYSDOC32.HLP>task',`SYSDOC_TASK_SAVE_CUSTOM_CONFIGURATION')}    
Create custom Norton System Doctor configurations

{button ,JI(`SYSDOC32.HLP>task',`SYSDOC_TASK_TO_SET_SENSOR_GAUGE_TYPE')}    
Customize sensor faces (display types)

{button ,JI(`SYSDOC32.HLP>task',`SYSDOC_TASK_DOCK')}    Dock and auto hide Norton System 
Doctor

{button ,JI(`SYSDOC32.HLP>task',`SYSDOC_TASK_TO_HIDE_ACTIVATED_SENSOR')}    Hide 
sensors

{button ,JI(`SYSDOC32.HLP>task',`SYSDOC_TASK_TO_KEEP_SYSDOC_ON_TOP')}    Keep 
Norton System Doctor visible at all times

{button ,AL(`To hide and show sensors;To add or remove sensors;To arrange sensors within the Norton 
System Doctor window;To display or hide the title and menu bars;To show all hidden sensors;To use 
custom configurations;To choose Norton System Doctor startup options;To create display schemes;To 
dock and auto hide Norton System Doctor;To keep Norton System Doctor visible at all times;To change 
the behavior of alarm messages',0,`',`')}    Related Topics



About sensor alarms

Most sensors include an alarm that can be triggered when the condition being monitored reaches a 
critical value. When triggered, the alarm alerts you to the condition by displaying a message 
suggesting corrective action. The sensor display also changes color when the alarm condition occurs. 
Optionally, you can have the sensor play a sound file when the alarm is triggered.

You can hide individual sensors without removing them from the Norton System Doctor window. 
Hidden sensors continue to monitor your system and notify you when alarm conditions exist. However, 
they don't appear with the other sensors.

Many sensors can be set to take corrective action automatically when conditions trigger an alarm. For 
example:

If an error condition has been detected on a disk, Norton System Doctor can run Norton Disk 
Doctor to correct the problem.

When disk image information has not been updated recently, Norton System Doctor can run 
Image to refresh the information.

When disk space is running low, Norton System Doctor can run Space Wizard to help you free up 
disk space by finding unnecessary or duplicate files.

Alarms can also help you tune the performance of your computer. For example, you can set alarms to 
notify you when your disk becomes highly fragmented, when your system's disk cache performance 
falls below a certain level, and when your physical memory (RAM) usage is high.

To determine an appropriate alarm setting for a sensor, make sure to consider current usage of the 
resource the sensor measures. Otherwise, the alarm could be triggered too frequently or not frequently 
enough. The default alarm trigger values should be adequate for most systems.

You can enable an alarm for every Norton System Doctor sensor except Current Date And Time, 
Windows Up Time, and Windows Performance Stats.

{button ,AL(`To enable and disable sensor alarms;To change the behavior of alarm messages;To hide 
and show sensors;When to hide sensors',0,`',`')}    Related Topics



About sensor maximum readings

Most sensors have an absolute maximum reading, which is the highest measurement possible for a 
particular sensor. For example, the absolute maximum reading for the Physical Memory sensor is the 
amount of RAM installed in the computer, and the absolute maximum reading for the Disk Space 
sensor is the total amount of space on the disk. Norton System Doctor uses the absolute maximum 
reading when displaying information in a sensor's history window.

Some Norton System Doctor sensors have no absolute maximum readings. For example, the Threads 
sensor shows the number of currently running threads. The upper limit to the number of threads 
depends upon many factors relating to the capabilities and configurations of individual computers.

If a sensor does not have an absolute maximum reading, you can let Norton System Doctor use the 
highest reading it has recorded as the maximum, or you can specify your own maximum as one of the 
sensor's Properties.

{button ,AL(`To reset Norton System Doctor sensors;To set sensor maximum value;about sensor 
history;to display sensor history',0,`',`')}    Related Topics



Norton System Doctor notes for network administrators

Norton System Doctor includes a number of sensors that can help you monitor the performance and 
usage of your network:

Disk Space sensor monitors the space either free or available on network drives (as well as on 
local hard drives).

Open Files sensor monitors the number of files that are open on network drives (as well as on 
local hard drives).

Network Reads Throughput (IPX) sensor measures the speed at which a particular computer 
reads data from an IPX    network drive through its network card.

Network Writes Throughput (IPX) sensor measures the speed at which a particular computer 
writes data to an IPX network drive.

Windows Performance Stats sensors provide information that is specific to your type of network. 
Examples of categories of network information available (if they are applicable to your network) are 
IPX/SPX Compatible Protocol, Microsoft Network Server, NCP Redirector, and SMB Redirector.

Other Norton System Doctor sensors can also be helpful in troubleshooting network problems. For 
example, if you're trying to determine why network performance on one computer is slower than on 
other comparable ones, many of the sensors can help you compare processing loads and capabilities.

Use System Information to get detailed network information.

{button ,AL(`About the Disk Space sensor;About the Network Reads Throughput sensor;About the 
Network Writes Throughput sensor;About the Open Files sensor;About Windows Performance Stats 
sensors',0,`',`')}    Related Topics



Command-line options for Norton System Doctor

You can run Norton System Doctor from the command line by choosing Run from the Start menu. Use 
the following syntax:

SYSDOC32 /RESET

/RESET Resets Norton System Doctor using the default sensors with their default properties.

{button ,AL(`When to reset Norton System Doctor;introducing Norton System Doctor',0,`',`')}    Related 
Topics





To add or remove sensors

Click here        to open Norton System Doctor.

To add a sensor

1 Click the Sensor menu of the Norton System Doctor window or choose Add Sensor from any 
sensor's context menu.

2 Select the sensor you want to add from the cascading menus.
For Windows Performance Stats sensors, select the category and item that defines the statistics 
you want to monitor.

To remove a sensor

1 Right-click the sensor.

2 Choose Remove from the context menu that appears.

{button ,AL(`To set sensor properties;To monitor Windows performance statistics;To hide and show 
sensors;Types of sensors;sd32 Options dialog active;sd32 properties dialog item',0,`',`')}    Related 
Topics



To set sensor properties

Sensor properties let you control the behavior and look of the sensors. You can control how often the 
sensor checks your system, the level at which the sensor alarm will be triggered, and what Norton 
System Doctor should do when the alarm is triggered. You can also control the look of the sensor face 
from the sensor properties.

1 Click here        to open Norton System Doctor.

2 Right-click the sensor whose properties you want to change.
3 Choose Properties from the context menu that appears.
4 Click the tab for the properties you want to set.

You can also choose Properties from the sensor's context menu or from the Edit menu of the 
Norton System Doctor window.

{button ,AL(`To add or remove sensors;To display sensor history;To monitor Windows performance 
statistics;To reset Norton System Doctor sensors;Types of sensors;sd32 Properties dialog',0,`',`')}    
Related Topics



To arrange sensors within the Norton System Doctor window

You can arrange the sensors in any order you prefer.

Click here        to open Norton System Doctor.

Drag any sensor to a new position in the Norton System Doctor window.
To drag a sensor, position the mouse over the sensor, press and hold the left mouse button, then 

move the mouse.

{button ,AL(`Customizing Norton System Doctor;To keep Norton System Doctor visible at all times;To 
dock and auto hide Norton System Doctor;To display or hide the title and menu bars;',0,)}    Related 
Topics



To display sensor history

Sensor history windows show the change in sensor readings over time. Most sensors can display 
history windows.

1 Click here        to open Norton System Doctor.

2 Right-click the sensor for which you want history information.
3 Choose History Window from the context menu that appears.

History information is not available for all sensors.

{button ,AL(`About sensor history;To reset Norton System Doctor sensors',0,`',`')}    Related Topics



To display or hide the title and menu bars

Click here        to open Norton System Doctor.

Check or uncheck Show Title Bar and Show Symantec Logo on the View menu of Norton System 
Doctor or on the View menu of any sensor's context menu. Clicking these menu items alternately checks 
and unchecks them.

You can also double-click areas in the Norton System Doctor window that are not occupied by 
sensors to turn the title and menu bars on and off.

You cannot display the title and menu bars when Norton System Doctor is docked.

{button ,AL(`Customizing Norton System Doctor;To dock and auto hide Norton System Doctor;To keep 
Norton System Doctor visible at all times',0,`',`')}    Related Topics



To enable and disable sensor alarms

Click here        to open Norton System Doctor.

To enable a sensor's alarm

1 Right-click the sensor.

2 Choose Properties from the context menu that appears.

3 Check Enabled in the Alarm Settings group.

To disable a sensor's alarm

1 Right-click the sensor

2 Choose Properties from the context menu that appears.

3 Uncheck the Enabled check box in the Alarm Settings group.

If you disable a sensor, its specified alarm action will not occur when the alarm condition is met 
and the sensor face will not change to indicate the alarm condition.

{button ,AL(`About sensor alarms;sd32 Properties dialog alarm;To set sensor alarm properties;To 
change the behavior of alarm messages',0,`',`')}    Related Topics



To hide and show sensors

You can hide individual Norton System Doctor sensors while they continue to monitor your system. 
Hidden sensors still warn you or take appropriate action when their alarms are triggered.

Click here        to open Norton System Doctor.

To hide a sensor

1 Right-click the sensor you want to hide.

2 Choose Properties from the context menu that appears.

3 Click the Style tab.

4 Check Hidden in the Sensor Size group.

To show all hidden sensors

Check Hidden Sensors on the View menu.
Clicking this menu item alternately checks and unchecks it, toggling the display of hidden 

sensors.

To unhide a single sensor

1 Click Hidden Sensors on the View menu to display all hidden sensors.

2 Right-click the sensor you want to unhide.

3 Choose Properties from the context menu that appears.

4 Click the Style tab.

5 Uncheck Hidden in the Sensor Size group.

6 Click Hidden Sensors on the View menu again to hide any other hidden sensors.

{button ,AL(`To dock and auto hide Norton System Doctor;sd32 Properties dialog style;When to hide 
sensors',0,`',`')}    Related Topics



To keep Norton System Doctor visible at all times

You can keep Norton System Doctor on top of all other windows, so it remains visible at all times.

Click here        to open Norton System Doctor.

Check Always On Top on the View menu of Norton System Doctor or on the View menu of any 
sensor's context menu.

{button ,AL(`Customizing Norton System Doctor;To dock and auto hide Norton System Doctor;To 
choose Norton System Doctor startup options;To hide and show sensors;To display or hide the title and 
menu bars',0,`',`')}    Related Topics



To dock and auto hide Norton System Doctor

You can reclaim desktop space by docking and auto hiding Norton System Doctor.

Click here        to open Norton System Doctor.

To dock Norton System Doctor

Check Dock on the View menu.

To undock Norton System Doctor

1 Right-click anywhere in the Norton System Doctor window.

2 Choose View from the context menu.

3 Uncheck Dock.

To auto hide Norton System Doctor

Check Auto Hide on the View menu. Auto hide is available only when Norton System Doctor is 
docked.

Norton System Doctor and the Windows taskbar cannot both be set to auto hide along the same 
edge of the screen.

{button ,AL(`Customizing Norton System Doctor;To choose Norton System Doctor startup options;To 
hide and show sensors;To keep Norton System Doctor visible at all times;To display or hide the title 
and menu bars;sd32 Options dialog window',0,`',`')}    Related Topics



To monitor Windows performance statistics

Windows Performance Stats sensors monitor the same information provided by the Windows System 
Monitor program.

1 Click here        to open Norton System Doctor.

2 Click the Sensor menu of the Norton System Doctor window.
3 Move the mouse over Performance.
4 Choose Windows Performance Stats from the cascading menu.
5 Select the category and item of information you want to monitor.

Add a separate sensor for each type of performance information you want to monitor.

{button ,AL(`About Windows Performance Stats sensors;sd32 properties dialog item',0,`',`')}    Related 
Topics



To open Norton Utilities programs from Norton System Doctor

1 Click here        to open Norton System Doctor.

2 Click the Utilities menu of Norton System Doctor.
3 Move the mouse over the category of program you want to start.
4 Click the name of the program you want to open.

{button ,AL(`About the links to other Norton Utilities programs',0,`',`')}    Related Topics



To reset Norton System Doctor sensors

Most sensors include a history window, which shows the change in sensor readings over time. You can 
reset a sensor at any time to clear this history information. You can also reset any sensor properties 
back to the original defaults, or reset Norton System Doctor to display the default sensors.

Click here        to open Norton System Doctor.

To reset a sensor's history readings

1 Right-click the sensor.

2 Choose Reset from the context menu that appears.

To reset a sensor's properties to the defaults

1 Right-click the sensor

2 Choose Properties from the context menu that appears.

3 Click the tab for the properties you want to reset.

4 Click Default.

To reset Norton System Doctor to the default sensors

1 Choose Options from the View menu.

2 Click the Active Sensors tab.

3 Click Default.

{button ,AL(`About sensor history;When to reset a sensor;When to reset Norton System Doctor;When 
to update a sensor',0,`',`')}    Related Topics



To set sensor alarm properties

Alarm properties control whether the alarm is enabled, the alarm trigger level, and the action that 
Norton System Doctor is to take when an alarm condition is detected.

1 Click here        to open Norton System Doctor.

2 Right-click the sensor
3 Choose Properties from the context menu that appears.
4 Set the alarm properties you want on the Alarm tab.

To activate the alarm, make sure Enabled is checked. Also make sure the alarm level you select 
is reasonable, so the alarm won't be triggered too frequently or too infrequently. Click Default on the 
Alarm tab to reset the sensor's alarm properties to the default settings.

{button ,AL(`About sensor alarms;sd32 Properties dialog alarm;To enable and disable sensor 
alarms;To change the behavior of alarm messages',0,`',`')}    Related Topics



To set the drive to be monitored

Sensors that monitor drive conditions can be set to monitor any of the local hard drives on your 
computer. Most can also be set to monitor all local hard drives simultaneously, and alert you when an 
alarm condition is detected on any of them.

1 Click here        to open Norton System Doctor.

2 Right-click the drive-monitoring sensor you want to set.
3 Choose Properties from the context menu that appears.
4 Click the Drive tab. The Drive tab is not available for all sensors.

To monitor all local hard drives

Click Monitor All Local Hard Drives (not available for all sensors).

To monitor a single drive

1 Click Monitor A Particular Drive (not available for all sensors).

2 Choose the drive to be monitored from the list.

{button ,AL(`sd32 Properties dialog drive;types of disk sensors',0,`',`')}    Related Topics



To change the sensor display type

Norton System Doctor provides a number of different sensor face styles from which to choose.

1 Click here        to open Norton System Doctor.

2 Right-click the sensor.
3 Choose Properties from the context menu that appears.
4 Click the Style tab.
5 From the Type drop-down list, click the type of graph you want displayed.

Not all sensors can display information in a graph format.

{button ,AL(`Types of sensors;to use custom configurations;To create display schemes;sd32 Properties 
dialog style;To set sensor measurement units',0,`',`')}    Related Topics



To set sensor maximum value

1 Click here        to open Norton System Doctor.

2 Right-click the sensor.
3 Choose Properties from the context menu that appears.
4 Click the Measurement tab.
5 Type the maximum value you want in the box labeled Maximum in the Sensor Maximum Reading 
group.

You cannot change the maximum reading for all sensors.

{button ,AL(`About sensor maximum readings;about sensor history;To set sensor measurement 
method;sd32 Properties dialog measurement',0,`',`')}    Related Topics



To set sensor measurement method

Many sensors can display their measurement as either the current actual value, or as a decaying 
average. A decaying average gives more weight to the more recent sensor readings.

1 Click here        to open Norton System Doctor.

2 Right-click the sensor.
3 Choose Properties from the context menu that appears.
4 Click the Measurement tab.
5 Click the option you want in the Measurement Type group.

Only sensors displaying information in graph format include this property.

{button ,AL(`To set sensor maximum value;To set sensor update interval;sd32 Properties dialog 
measurement;sd32 Properties dialog DHmeasurement',0,`',`')}    Related Topics



To set sensor size

You can specify whether a sensor is displayed in a large or small style. The large style is the same 
height as the small style, but is twice the width.

1 Click here        to open Norton System Doctor.

2 Right-click the sensor.
3 Choose Properties from the context menu that appears.
4 Click the Style tab.
5 Click Large or Small in the Sensor Size group.

You can also set the relative height and width of sensors by choosing Options from the View 
menu and using the sliders on the Sensor Appearance tab. Note that this setting applies to all sensors, 
while the large or small style setting applies only to a single sensor.

{button ,AL(`Customizing Norton System Doctor;sd32 Properties dialog style;To create display 
schemes;To use custom configurations;To set a sensor graph type',0,`',`')}    Related Topics



To set sensor measurement units

1 Click here        to open Norton System Doctor.

2 Right-click the sensor.
3 Choose Properties from the context menu that appears.
4 Click the Style tab.
5 Select the units of measure you want from the Sensor Scale group.

You cannot change the unit of measurement for some sensors, either because they do not 
display information in graph format or because they have only one unit type available.

{button ,AL(`To change sensor display type;sd32 Properties dialog style',0,`',`')}    Related Topics



To set sensor update interval

You can specify how frequently many of the sensors update their readings.

1 Click here        to open Norton System Doctor.

2 Right-click the sensor.
3 Choose Properties from the context menu that appears.
4 Click the Measurement tab.
5 Drag the Time Between Sensor Readings slider to the interval setting you want.

It is usually best to use the default setting for this option.
Every sensor reading consumes a small portion of system resources. If the time between sensor readings 
is set too short, the sensor will use more system resources while not necessarily providing much new 
information. If the time between readings is set too long, there may be a delay before problems are 
detected.

{button ,AL(`To set sensor maximum value;To set sensor measurement method;To change the 
behavior of alarm messages',0,`',`')}    Related Topics



To choose Norton System Doctor startup options

You can have Norton System Doctor start automatically whenever Windows starts. You can also 
specify that Norton System Doctor always run minimized (as an icon at the right side of the Windows 
taskbar).

1 Click here        to open Norton System Doctor.

2 Choose Options from the View menu.
3 Click the Window Settings tab.

To have Norton System Doctor run minimized

Check Start Minimized in the Startup Options group. Norton System Doctor will minimize itself 
automatically the next time it is started. When minimized, Norton System Doctor still notifies you of 
problems, or can fix them automatically as they are detected.

To open Norton System Doctor at Windows startup

Check Start Automatically With Windows in the Startup Options group. Norton System Doctor will 
start automatically the next time Windows is started.

{button ,AL(`To dock and auto hide Norton System Doctor;To keep Norton System Doctor visible at all 
times;To create display schemes;sd32 Options dialog window',0,`',`')}    Related Topics



To update sensor readings

At any time, you can update a sensor's display to show the current reading. For the disk and virus 
sensors, this initiates a new system scan.

Click here        to open Norton System Doctor.

1 Right-click the sensor.

2 Choose Update from the context menu that appears.

{button ,AL(`When to reset a sensor;When to update a sensor',0,`',`')}    Related Topics



To use custom configurations

You can create and store several different custom configurations for Norton System Doctor and use 
them for different monitoring tasks.

Click here        to open Norton System Doctor.

To save a custom configuration

Choose Save Configuration As from the File menu to save the current configuration with a new 
name. The configuration will become the new default configuration, used whenever you open Norton 
System Doctor.

To open a custom configuration

1 Choose Open Configuration from the File menu.

2 Find and select the configuration file you want to open.

{button ,AL(`to add or remove sensors;To use custom configurations;To create display 
schemes;Customizing Norton System Doctor',0,`',`')}    Related Topics



To create display schemes

Display schemes let you change the overall look of Norton System Doctor. You can create any number 
of display schemes and switch between them at any time.

Click here     to open Norton System Doctor.

To set sensor dimensions

1 Choose Options from the View menu.

2 Use the sliders on the Sensor Appearance tab to adjust the sample sensor's height and width.

These dimensions apply to all sensors, and are stored with the display scheme, while the Large 
or Small Style sensor property applies to only a single sensor, and is stored with a custom configuration.

To set sensor colors, fonts, and background bitmaps

1 Choose Options from the View menu.

2 From the Item list box on the Sensor Appearance tab, click the sensor component whose color or 
font you want to change.

3 Click Color or Font.

4 In the Bitmap Background box, type in the path and name of a bitmap (.BMP) file, or click the open 
folder icon to browse for a bitmap graphic file.

The background bitmap feature is enabled only if your display is set to show more than 256 
colors.

To save your display scheme

You can save your custom sensor dimensions, colors, fonts, and bitmap background as a display 
scheme, and use it at any time.

From the Sensor Appearance tab, click Save As and choose a name for your suite of settings. 
You can go to the Sensor Appearance tab to change the display scheme at any time.

{button ,AL(`Customizing Norton System Doctor;To set sensor size;To use custom configurations;To 
set a sensor graph type;To display or hide the title and menu bars;To dock and auto hide Norton 
System Doctor;To keep Norton System Doctor visible at all times;To create display schemes;sd32 
Options dialog appearance',0,`',`')}    Related Topics



To specify files to be scanned for viruses

You can specify which file types are scanned for viruses.

1 Click here     to open Norton System Doctor.

2 Right-click the Norton AntiVirus SE Scan sensor.
3 Choose Properties from the context menu that appears.
4 Click the Files To Scan tab.

To add a new file type to be scanned 

1 Click Add.

2 Type the file extension for the new file type.

To remove a file type from virus scanning 

1 Click the extension for the file type in the list.

2 Click Remove.

{button ,AL(`about the Norton AntiVirus SE Scan sensor;sd32 properties dialog files',0,`',`')}    Related 
Topics





Disk Throughput sensor

This sensor measures the speed at which your computer handles requests for data stored on disk. 
Because some of this data is pre-loaded into the disk cache (a part of memory set aside to temporarily 
store data from your disk), the measurement is influenced by both the speed of the system RAM and the 
speed of disk accesses.



Disk Space sensor

Shows the amount of free disk space available on a local or network hard disk.



Threads sensor

Shows the number of threads (subprocesses) currently running on the computer. Having too many 
threads running concurrently can waste memory and degrade system performance.



Memory Load sensor

This sensor reports computer memory usage by monitoring how much of the memory has been 
committed to running applications.

When all the physical memory (RAM) has been committed, Windows can commit additional memory from 
the virtual memory of the swap file. However, applications run faster when they are entirely resident in 
RAM.

When this sensor indicates a high memory load, you should try to close some applications.



Physical Memory sensor

Shows how much of the physical memory (RAM) is free. Windows uses much of the available RAM as a 
disk cache, so this sensor generally shows only a small amount of RAM free. Windows changes the size 
of the cache dynamically, however, freeing up RAM as needed for other applications.



Swap File Size sensor

Shows the amount of free disk space currently reserved for use by the Windows swap file. By default, 
Windows dynamically enlarges and reduces the swap file according to the demands of the system.



CPU Usage sensor

Shows the time the CPU spends executing instructions relative to the time it is idle.

It is fairly common for the CPU usage to jump to 100% during some operations, such as loading 
programs. Also note that using Windows' Advanced Power Management feature or certain 16-bit device 
drivers can prevent the CPU usage from ever falling to a low value.



Cache Hits sensor

Shows how much of the data required by applications is found in the disk cache. If data is not found in the 
cache, it must be read directly from the disk, which is a slower process.



Network Reads Throughput (IPX) sensor

Shows the speed at which your computer reads data from a Novell NetWare network.



Network Writes Throughput (IPX) sensor

Shows the speed at which your computer writes data to a Novell NetWare network.



Windows Performance Stats sensors

Show various performance statistics provided by Windows. These sensors show the same types of 
information reported by the Windows System Monitor program. You can add multiple sensors to monitor 
different types of performance data. Though some of this information duplicates native System Doctor 
sensors, Windows Performance Stats sensors do not include sensor alarms.



Cache Memory Utilization sensor

Shows the amount of physical memory (RAM) currently in use for the disk cache.



Open Files sensor

Shows the number of files that are currently open on a local or network hard disk. A large number of open 
files can degrade system performance.



GDI Resources sensor

Shows the available Windows Graphics Device Interface (GDI) memory resources. To run applications, 
Windows requires free GDI resources. When these resources are exhausted, additional applications 
cannot be opened, and you receive out-of-memory errors. When GDI resources are low, you should close 
any unnecessary applications to free up some memory.



USER Resources sensor

Shows the available Windows USER memory resources. Part of USER resources must be allocated from 
a fixed-size area of memory. This sensor measures the portion of that memory area that is free.



Selectors (16-bit) sensor

Shows the number of 16-bit selectors currently available. 16-bit Windows applications require 16-bit 
selectors for memory management.

A total of 8192 selectors are available under Windows. Some applications use hundreds of selectors. 
When no selectors are available, out-of-memory errors result, and you cannot open more 16-bit 
applications. When the alarm is triggered, you should close any unnecessary applications.



DOS Memory sensor

Shows how much conventional memory (the lower 640K of RAM) is available.

Windows loads any real-mode, DOS-based device drivers into the DOS memory region. Some 
applications designed to run under Windows 3.x also must use the DOS memory region. Real-mode 
drivers reduce the amount of memory available to such applications. When DOS memory is low, you may 
not be able to open certain applications.



Battery Power sensor

Shows the charge remaining in a portable computer's battery.



Windows Up Time sensor

Shows the time that has elapsed since Windows was last started.



Current Date And Time sensor

Shows the current date and time.



Disk Optimization sensor

Shows the level of disk fragmentation. This sensor can alert you or automatically run Speed Disk to 
defragment and optimize the disk whenever fragmentation of the used disk space exceeds a critical level.



Disk Doctor sensor

Monitors the integrity of a disk's logical file structures (including compressed disk structures, if any). It 
periodically scans the disk, checking for file allocation table errors, cross-linked files, and lost clusters.

A red light means significant problems exist, a yellow light means only lost clusters are detected, and a 
green light means no problems have been detected.

Use the Disk Doctor Surface Test sensor to periodically scan the disk surface for errors.



Image sensor

Shows how recently the disk was imaged and can alert you or run Image automatically after a specified 
amount of time has elapsed. Image takes a "snapshot" of critical disk information for a local disk drive. 
This information, the disk "image," can be used to unformat a disk and can help to unerase files or 
folders.

A red light on the sensor indicates that the time period specified by the sensor's alarm properties has 
expired, and it is time to run Image again.



Rescue Disk sensor

This sensor periodically checks your system's critical setup data and startup files. The sensor alerts you 
when any of these files has changed, and detects whether any new files should be added to your rescue 
disk set.

A rescue disk set stores copies of these important files on removable media (floppy, Zip , or Jaz

 disks). If your computer fails to start, you can use your rescue disk set to get the computer running 
again. Once the computer has been started, you can use Norton Utilities to help fix any problems, and 
restore your computer to full functioning.

It is vital that the information on your rescue disks be kept current. The Rescue Disk sensor can alert you 
or automatically run Rescue Disk to update the information whenever necessary. You should not add 
multiple Rescue Disk sensors to the Norton System Doctor sensor panel.



Disk Doctor Surface Test sensor

This sensor periodically scans the surface of a local disk. The bar on the sensor face indicates the 
progress of the current surface scan. The sensor can alert you or automatically run Norton Disk Doctor if 
a surface problem is detected, preventing problems that would result from disk failures.



Norton AntiVirus Definitions sensor

Shows whether your virus definitions files are current. Keeping your virus definitions files up to date 
guarantees that the Norton AntiVirus SE Scan sensor can identify the latest viruses that have been 
described.

If your computer is connected to a modem or the Internet, this sensor can use Symantec's LiveUpdate 
technology to get new virus definitions automatically. Updated virus definitions files are made available 
periodically from Symantec Corporation, and can also be downloaded from Symantec's World Wide Web 
site, from many computer bulletin boards, or can be mailed to you directly from Symantec Corporation.

A red stoplight does not mean your system is infected with a virus. It means your virus definitions 
files are getting old. This sensor turns green only when the virus definitions on your machine are newer 
than the age set on the Alarm tab of this sensor's Properties.



Norton AntiVirus SE Scan sensor

Uses advanced Norton AntiVirus technology to periodically scan your system for computer viruses. It can 
repair most viruses that are detected. The sensor's stoplight face turns red whenever a virus is found, and 
the sensor can alert you with an alarm message, or automatically initiate repairs.



Disk SMART status sensor

Warns you of imminent disk hardware failures, allowing you time to back up files and replace the disk 
drive before losing valuable data.

Self-Monitoring, Analysis, and Reporting Technology (SMART) is built into newer IDE hard drives. It 
allows these drives to monitor their own operation and predict most drive hardware failures before they 
occur. The Disk SMART sensor works together with SMART drives to alert you to these conditions.

This sensor only supports drives that have SMART built-in.



Disk Slack Space sensor

Shows the amount of slack space on a disk.

The operating system allocates (reserves) space for files in discrete chunks. Most files, however, occupy 
less physical space on the disk than the operating system has reserved. Slack space is the excess space 
allocated for a file that remains unoccupied by any of that file's data. Once allocated for a particular file, 
disk space cannot be used for any other purpose, so slack space is essentially disk space that is wasted. 
Using a smaller cluster size, as the FAT32 file system does, helps minimize slack space.





Norton Protected Files sensor

This sensor shows the number of files currently under Norton Protection. Norton Protection enhances the 
file recovery capabilities offered by the Windows Recycle Bin. Norton Protection lets you recover 
overwritten files, files deleted from a DOS window, and files deleted by Windows applications. As long as 
these files are protected, they can be recovered intact, even after their deletion.



Norton Utilities LiveUpdate sensor

This sensor periodically displays an alarm message reminding you to check for updates to Norton 
Utilities. If your computer is connected to a modem or to the Internet, this sensor can use Symantec's 
LiveUpdate technology to get Norton Utilities updates automatically when they become available.



Internet Packet Turnaround sensor

Shows the speed of Internet packet transmission between your computer and a host site of your choice.



Internet Speedometer sensor

Shows the speed of your Internet connection to the host site of your choice.



Shows how all small-style sensors will look with the current appearance options. The large-style sensors 
are always twice the width of the small-style sensors. Use the horizontal and vertical sliders to change the 
sensor dimensions.



Drag the slider or click anywhere along the slider scale to change the height of all sensors.



Drag the slider or click anywhere along the slider scale to change the width of all small-style sensors. 
Norton System Doctor automatically sets the width of large-style sensors to twice this width.



Click the box to list the available display schemes. A scheme defines the sensor dimensions, colors, text 
fonts, and background bitmap use for the Norton System Doctor window. You can choose one from the 
list, or use this tab to create a new scheme.

The background bitmap feature is enabled only if your display is set to support more than 256 
colors.



Saves the sensor dimensions, colors, text fonts, and background bitmap currently set on this tab as a 
new display scheme. After you specify a name for the new scheme, it will appear in the list. You can 
switch Norton System Doctor between display schemes at any time.

The background bitmap feature is enabled only if your display is set to support more than 256 
colors.



Deletes the selected scheme.



Click to specify the color assigned to the selected sensor component.



Click the box to show a list of sensor components. Click a component from the list to change its color or 
font.



Click to specify the font used for text or calendar text.



Type the path and name of a bitmap to be used as the background image for all sensors, or click the 
folder icon  to browse your system for a bitmap.

The background bitmap feature is enabled only if your display is set to support more than 256 
colors.



Lets you browse your system for a bitmap to use as the background image on the Norton System Doctor 
sensors.

The background bitmap feature is enabled only if your display is set to support more than 256 
colors.



Resets all Norton System Doctor Sensor Appearance properties to their default settings.



Lists the currently active sensors in the order they appear in the Norton System Doctor window.



Moves the sensor selected in the Sensor Order list box up one position. The Norton System Doctor 
window reflects the order of the sensors as they appear in the Sensor Order list.



Moves the sensor selected in the Sensor Order list box down one position. The Norton System Doctor 
window reflects the order of the sensors as they appear in the Sensor Order list.



Keeps the Norton System Doctor window on top of any other windows on your desktop.



Controls whether the Norton System Doctor window title bar is displayed. When the title bar is hidden, 
you can restore it by right-clicking any sensor and choosing Show Title Bar from the View menu.

Double-clicking any sensor-free portion of the Norton System Doctor window toggles the display 
of the title bar.



Controls whether the Symantec logo bar is displayed on the side of the Norton System Doctor window.



Hides the Norton System Doctor window by reducing it to a thin gray line along one edge of the screen. 
Moving the mouse cursor against the line redisplays the full Norton System Doctor window.

Norton System Doctor must be docked in order to use the auto hide feature. Norton System 
Doctor and the Windows taskbar cannot both be set to auto hide along the same edge of the screen.



The Auto Hide feature is available only when Norton System Doctor is docked.

Norton System Doctor and the Windows taskbar cannot both be set to auto hide along the same 
edge of the screen.



Docks the Norton System Doctor window, snapping it to the edge of the display. You can drag the docked 
window to any of the four edges of the display. Though the menu bar is hidden, you can access all menu 
options by right-clicking to display a context menu. You can move the sensors within the docked window 
by holding down the Control (Ctrl) key and dragging sensors to new positions.



Automatically starts Norton System Doctor whenever you start Windows.



Causes Norton System Doctor to open minimized, so it appears only as an icon in the Windows taskbar. 
To restore the full Norton System Doctor window, click the icon.



Resets all Norton System Doctor window settings to their defaults.



Lists all Norton System Doctor sensors. Select the sensors you want to add to the Norton System Doctor 
window, then click Add.



Lists the Norton System Doctor sensors that are currently active.



Adds the sensors currently selected in the Available Sensors list box to the Current Sensors list box. 
These sensors are added to the Norton System Doctor window and begin monitoring your system when 
you click OK or Apply.

(This command button is not enabled until you have selected one or more sensors in the Available 
Sensors list box.)



Lets you set the properties for the sensor selected in the Current Sensors list box.

(This command button is not enabled until you have selected a sensor in the Current Sensors list box.)



Removes the selected sensors from the Current Sensors list box. These sensors are deactivated and 
removed from the Norton System Doctor window when you click OK or Apply. The sensors are not 
removed from the Available Sensors list, so they can be added back to the Norton System Doctor window 
at any time.

(This command button is not enabled until you have selected a sensor in the Current Sensors list box.)



Configures Norton System Doctor to have only the default sensors active.



Shows how the sensor looks with the currently selected style properties.



Resets this sensor's style properties to their default settings.



Click to show a list of the different visual formats available for this sensor. Sensors that display 
information in graph formats can appear as:

Bar graphs
Analog gauges similar to automobile fuel gauges
Histograms that display multiple readings collected over a period of time
Digital readouts

This list is disabled for sensors that do not display information as graph sensors.



Displays the sensor in a large-style format.



Displays the sensor in a small-size format.



Hides the sensor so it doesn't appear in the Norton System Doctor window. Although the sensor is 
hidden, it is still active and will still monitor its assigned condition and trigger its alarm, if the alarm is 
enabled.



Causes the sensor to display how much of the resource being monitored is available. The sensor label 
changes to reflect what the sensor is displaying. This option button is not available if it is not meaningful 
for this sensor.



Causes the sensor to display how much of the resource being monitored is in use. The sensor label 
changes to reflect what the sensor is displaying. This option button is not available if it is not meaningful 
for this sensor.



Causes the sensor to display how much of the data on the drive being monitored is fragmented. 
Fragmented data is not stored in contiguous (side-by-side) data clusters, so it takes longer to access and 
manipulate.



Causes the sensor to display how much of the data on the drive being monitored is unfragmented. 
Unfragmented data is stored to contiguous (side-by-side) data clusters and can be accessed and 
manipulated faster than fragmented data.



Click the down arrow to display a list of the units of measurement available for this sensor. From the list 
choose the units you want this sensor to use. The sample graphic will reflects the units. This list is not 
available if there are no measurement unit options for this sensor.



Resets all style properties for this sensor to their default settings.



Check to enable the alarm. Uncheck to disable the alarm. When an alarm is enabled, the alarm action 
occurs when the alarm is triggered.



Sets the trigger level the level at which the alarm action is to occur. As you adjust the slider, the number 
corresponding to its position appears in the text box.

This option is not available for all sensors.



Lets you set the trigger level the level at which the alarm action is to occur.



Clicking the down arrow displays a list of the units of measurement available for this sensor's trigger. Click 
the units you want to use. This drop-down list box is not available if there are no measurement options for 
this sensor.



Shows how the sensor looks with the currently selected Alarm properties.



Check to show an indication of the trigger level on the sensor face. When the monitored condition 
reaches or exceeds the trigger level, the sensor face displays its warning color, and the alarm action is 
triggered.

You can use the slider below to change the trigger level.



Click to prevent Alert, Caution, and Notice messages from appearing when the alarm is triggered. When 
the alarm is triggered, the sensor will only change from its normal color to its warning color.



Click to have the sensor display an Notice, Caution, or Alert message when the alarm is triggered. These 
messages call your attention to critical conditions quickly. The messages also recommend corrective 
action to alleviate the alarm condition and restore computer performance.



Type in the number of minutes you want to elapse before Alerts, Notices, and Cautions will be displayed 
again. If you close one of these message dialog boxes, Norton System Doctor will wait for the specified 
time before displaying the message again if the alarm condition has not been alleviated.



Click to have Norton System Doctor automatically take corrective action when the alarm is triggered by 
starting the appropriate Norton Utilities program.

This option is not available for all sensors



Click to configure the Norton Utilities program used to make automatic repairs.

This option is not available for all sensors



Check to have Norton System Doctor play a sound file (.WAV or .MID format) whenever the alarm for this 
sensor is triggered. Type the name of the sound file in the box at the left, or use the folder button  to 
browse your system for a sound file to play.



Type the name of a sound file (.WAV or .MID format) to be played when the alarm is triggered. This text 
box is enabled only if Play Sound is checked.



Click to browse your drives for the name of a sound file (.WAV or .MID format) to play when the alarm is 
triggered.



Plays the sound file specified in the box at the left.



Lets you specify how old image, rescue, or virus definitions information can become before the alarm is 
triggered. Specify the frequency at which you want the alarm triggered. The alarm can remind you to run 
Image (for the Image sensor) or Rescue Disk (for the Rescue Disk sensor), or can run those programs 
automatically for you at the specified intervals.



Lists the units of time for the alarm trigger. The options are minutes, hours, days, and weeks.



Prevents the alarm from being triggered if the only problems detected are lost clusters.



Resets all alarm properties for this sensor to their default settings.



Drag the slider to change how frequently the sensor updates its readings. The text under the slider 
indicates the current setting.



Click to have the sensor display the actual current reading detected by the sensor.

This option is disabled if it has no meaning for this sensor.



Click to have the sensor to show an averaged reading, weighted in favor of the most recent readings.

This option is disabled if it has no meaning for this sensor.



Click to have Norton System Doctor establish the maximum reading for this sensor. Initially, the maximum 
reading is the number displayed in the Maximum text box. If the sensor records a reading that is higher 
than that number, the highest reading becomes the maximum. Norton System Doctor displays the 
maximum reading in the history window and uses it to calculate the percentage of the sensor's resource 
relative to the maximum.

This option is disabled if the sensor has an absolute upper limit.



Click to limit the maximum value for the sensor to the number entered in the Maximum box below. Norton 
System Doctor displays the maximum reading in the history window and uses it to calculate the 
percentage of the sensor's resource relative to the maximum.

This option is disabled if the sensor has an absolute upper limit.



Lets you enter an upper limit for this sensor's readings:

If Let System Doctor Control is selected, the number in this text box is the starting maximum. If 
the sensor records an actual reading that is higher than this number, the maximum reading is set equal to 
the higher reading.

If Use Fixed Maximum is selected, you can type a number in this text box to set a fixed maximum 
reading for the sensor.

Norton System Doctor displays the maximum reading in the sensor's history window and uses it to 
calculate the percentage of the sensor's resource that is used or free.

This option button is disabled if the sensor has an absolute upper limit.



Resets all measurement-related sensor properties to their default settings.



Displays a list of the drives that this sensor can monitor. Click the drive you want this sensor to monitor. 
To monitor more than one drive, set up a separate sensor for each.

Some sensors include an option to Monitor All Local Hard Drives. These sensors can monitor all 
local drives simultaneously, and warn you if problems are detected on any one.



Drag the slider or click anywhere on the slider bar to change how frequently the sensor scans the disk.

The Disk Doctor and Disk Optimization sensors get their information from the same disk scan. 
Consequently, adjusting the slider setting for one of these sensors, affects the scan for both.



Drag the slider or click anywhere on the slider bar to change how long the sensor waits before rescanning 
after a scan is interrupted (or if a scan cannot be performed) because of other system activity.

The Disk Doctor and Disk Optimization sensors get their information from the same disk scan. 
Consequently, adjusting the slider setting for one of these sensors affects the scan for both.



Lists the categories of performance data that can be monitored. The specific categories available depend 
on your system configuration. At a minimum, the list box includes File System, Kernel, and Memory 
Manager.



Lists the type of performance data that can be monitored. When you click OK, a sensor for the selected 
item is added to the Norton System Doctor window.

(You can add multiple sensors to monitor different types of performance data provided by Windows.)



Describes what the item measures.



Displays the title that appears with this sensor if you use the large sensor style, and lets you enter a 
different title.



Displays the title that appears with this sensor if you use the small sensor style, and lets you enter a 
different title.



Resets the Title and Abbreviated Title to their default values for this sensor.



Displays a brief explanation of the alarm condition.



Displays suggestions for correcting the alarm condition.



Closes this message box for a specified period of time, then redisplays the message if the alarm condition 
still exists. (The period of time is one of the sensor properties you can set on the Alarm tab of the sensor's 
Properties dialog box.)



Closes this message box and sets the alarm action for this sensor to No Action. (You can reset the alarm 
action from the Alarm tab of the sensor's Properties dialog box.)



Opens the property sheet for this sensor so you can review or change the sensor's properties.



Opens the application that can take corrective action appropriate to this alarm condition.



Histogram displaying several of the sensor's measurements collected over a period of time. The x-axis 
shows the elapsed time. The y-axis shows the units of the condition that the sensor is monitoring.



Shows the current sensor values, the results of the most recent sensor reading. You can change the 
frequency of sensor readings from the Measurement tab of the sensor's Properties dialog box.



Shows the highest value recorded by this sensor since it was first added or since the last time it was 
reset.



Shows the lowest value recorded by this sensor since it was first added or since the last time it was reset.



Shows the value at which the sensor's alarm action is triggered if the sensor alarm is enabled.



Shows the minimum reading possible for this sensor.



Shows the maximum reading possible for this sensor. The sensor uses the maximum to calculate relative 
percentages and display them in the graph. If this sensor has no absolute maximum, you can fix your own 
maximum as one of the sensor properties (using the Measurement tab). Otherwise, the maximum is the 
same as the highest reading.



Saves any changes you have made within this tab and causes them to take effect immediately. This 
command button is unavailable until you have made one or more changes.



Checks for updates to this version of Norton Utilities. If updates are available, your copy can be 
automatically upgraded.



Displays a list of file types that the Norton AntiVirus SE Scan sensor will check for viruses. Use Add and 
Remove to modify this list.



Adds extensions to the list of file types that the Norton AntiVirus SE Scan sensor will check for viruses.



Removes extensions from the list of file types that the Norton AntiVirus SE Scan sensor will check for 
viruses.





DOS Memory sensor

GDI Resources sensor

Memory Load sensor

Physical Memory sensor

Selectors (16-bit) sensor

Swap File Size sensor

Swap File Utilization sensor

User Resources sensor

Virtual Memory sensor



Disk Optimization sensor

Disk Health sensor

Image sensor

Disk Doctor sensor

Disk Slack Space sensor

Disk SMART Status sensor

Disk Space sensor

Disk Doctor Surface Test sensor



Battery Power sensor

CPU Usage sensor

CrashGuard+ sensor

Norton AntiVirus Definitions sensor

Norton AntiVirus SE Scan sensor

Open Files sensor

Rescue Disk sensor

Threads sensor

WinDoctor sensor



Internet Packet Turnaround sensor

Internet Speedometer sensor

Network Reads Throughput (IPX) sensor

Network Writes Throughput (IPX) sensor



Cache Hits sensor

Cache Memory Utilization sensor

Disk Throughput sensor

Windows Performance Stats sensors



Current Date And Time sensor

Norton Protected Files sensor

Norton Utilities LiveUpdate sensor

Windows Up Time sensor



About the Disk Health sensor

This sensor monitors the overall health of local hard disks. It checks several aspects of disk health, 
including file system integrity, disk image information, and SMART drive status. The sensor alerts you 
when it detects problems, and in many cases can run the appropriate Norton Utilities program to fix 
problems automatically.

You can also have a single Disk Health sensor monitor all local hard disks with non-removable 
media. It will alert you when problems are found on any of the monitored drives. On the Drive tab of this 
sensor's Properties, click Monitor All Local Hard Drives. (You should not set multiple Disk Health sensors 
to Monitor All Local Hard Drives.)

From the Measurement tab of this sensor's Properties, you can control how frequently the sensor 
scans for the different disk conditions. The Disk Integrity scan frequency matches that set for the Disk 
Doctor and Disk Optimization sensors.

In addition to hard disks, this sensor can monitor high-capacity, removable media, such as Iomega's 
Zip  and Jaz

 drives. However, when a single Disk Health sensor is set to monitor all local hard drives, removable 
media drives are excluded.

{button ,AL(`Introducing Norton System Doctor;About sensor alarms;About the Disk Optimization 
sensor;Types of disk sensors;Types of sensors',0,`',`')}    Related Topics



Disk Health sensor

Monitors several aspects of disk health, including file system integrity, disk image information, and 
SMART drive status.

You can also have a single Disk Health sensor monitor all local hard disks with non-removable 
media. It will alert you when problems are found on any drive. (You should not set multiple Disk Health 
sensors to Monitor All Local Hard Drives.)



Properties: Style tab

The Style tab lets you configure the look of individual sensors.

This tab contains the following:

Sample sensor graphic
Shows how the sensor looks with the currently selected style properties.

Sensor Display
Click to show a list of the different visual formats available for this sensor. Sensors that display 
information in graph formats can appear as bar graphs, line graphs, analog gauges similar to 
automobile fuel gauges or speedometers, digital readouts, or histograms that display multiple 
readings collected over a period of time.
This list is disabled for sensors that do not display information as graph sensors.

Sensor Size
This group includes three options: large, small, and hidden. The large sensor style is twice as wide 
as the small style. Hidden sensors don't appear in the Norton System Doctor window, but are still 
active monitoring the system and can still trigger their alarms when conditions become critical.

Sensor Scale
Click the down arrow to display a list of the units of measurement available for this sensor. From 
the list choose the units you want this sensor to use. The sample graphic will reflects the units. This 
list is not available if there are no measurement unit options for this sensor.

Amount Free and Amount Used

% Fragmented and % Unfragmented

% Hits and % Misses
Most sensors can display their information in one of two complementary ways. For example, the 
Disk Space sensor can display the amount of disk space that is currently free or used. The Disk 
Optimization sensor can display the percentage of the disk that is fragmented or unfragmented. 
The Cache Hits sensor can display the percentage of cache hits or misses. Click the type of display 
you want.

Default
Click to reset the sensor style properties back to the defaults.

{button ,AL(`sd32 properties dialog;to hide and show sensors;To change sensor display type;to set 
sensor size;to set sensor measurement units',0,`',`')}    Related Topics



Properties: Alarm tab

The Alarm tab let's you configure the sensor's alarm. From here, you can enable and disable the alarm, 
set the alarm trigger level, and determine what happens when the alarm is triggered.

This tab contains the following:

Sample sensor graphic
Shows how the sensor looks with the currently selected Alarm properties.

Enabled
Check to enable the alarm. Uncheck to disable the alarm. When an alarm is enabled, the alarm 
action occurs when the alarm is triggered.

Show Trigger Level
Check to show an indication of the trigger level on the sensor face. When the monitored condition 
reaches or exceeds the trigger level, the sensor face displays its warning color, and the alarm 
action is triggered.

Auto Trigger Level (available only for the Disk Optimization sensor)
Check to have Norton System Doctor automatically choose an appropriate trigger level based on 
the amounts of used space and fragmentation on the disk.

Trigger Level
Use this slider to change the trigger level. The trigger level is displayed in the box below. You can 
also change the trigger level by typing a value directly into the box below and selecting the 
measurement units.

No Action
Click to prevent Alert, Caution, and Notice messages from appearing when the alarm is triggered. 
When the alarm is triggered, the sensor will only change from its normal color to its warning color.

Display Alarm Message
Click to have the sensor display Alert, Notice, and Caution messages when the alarm is triggered. 
These messages call your attention quickly to critical conditions. The messages also recommend 
the corrective action you should take to alleviate the alarm condition and restore computer 
performance.

Fix Automatically
Click to have Norton System Doctor automatically take corrective action when the alarm is triggered 
by starting the appropriate Norton Utilities program. This option is not available for all sensors.

Settings
Click to configure the Norton Utilities program used to make automatic repairs. This option is not 
available for all sensors.

Fix At
Check this box to schedule the repair for a later time. Type the time you want the repairs performed 
in the box provided.

Play Sound
Check to have Norton System Doctor play a sound file (.WAV or .MID format) whenever the alarm 
for this sensor is triggered. Type the name of the sound file in the box at the left, or use the folder 
button  to browse your system for a sound file to play.

Default
Click to reset the sensor alarm properties back to the defaults.

{button ,AL(`sd32 properties dialog',0,`',`')}    Related Topics



Properties: Measurement tab

The Measurement tab lets you configure the sensor's measurement. For most sensors, you can 
specify how frequently the sensor monitors a condition, how the measurements are averaged, and the 
maximum value for the sensor.

This tab contains the following:

Time Between Sensor Readings
Drag the slider to change how frequently the sensor updates its readings. The text under the slider 
indicates the current setting.

Actual Value
Click to have the sensor display the actual current reading detected by the sensor. This option is 
disabled if it has no meaning for this sensor.

Decaying Average
Click to have the sensor to show an averaged reading, weighted in favor of the most recent 
readings. This option is disabled if it has no meaning for this sensor.

Let System Doctor Control
Click to have Norton System Doctor establish the maximum reading for this sensor. Initially, the 
maximum reading is the number displayed in the Maximum text box. If the sensor records a reading 
that is higher than that number, the highest reading becomes the maximum. Norton System Doctor 
displays the maximum reading in the history window and uses it to calculate the percentage of the 
sensor's resource relative to the maximum. This option is disabled if the sensor has an absolute 
upper limit.

Use Fixed Maximum
Click to limit the maximum value for the sensor to the number entered in the Maximum box below. 
Norton System Doctor displays the maximum reading in the history window and uses it to calculate 
the percentage of the sensor's resource relative to the maximum. This option is disabled if the 
sensor has an absolute upper limit.

Maximum
Shows the upper limit for this sensor's readings:

If Let System Doctor Control is selected, the number in this text box is the starting maximum. If the 
sensor records an actual reading that is higher than this number, the maximum reading is set equal 
to the higher reading.

If Use Fixed Maximum is selected, you can type a number in this text box to set a fixed maximum 
reading for the sensor.

Norton System Doctor displays the maximum reading in the sensor's history window and uses it 
to calculate the percentage of the sensor's resource that is used or free.

This option is disabled if the sensor has an absolute upper limit.

Default
Resets this sensor's measurement properties back to the defaults.

{button ,AL(`To set sensor measurement method;To set sensor maximum value;sd32 properties 
dialog',0,`',`')}    Related Topics



Properties: Measurement tab (Disk Health sensor)

The Measurement tab lets you choose how frequently the Disk Health sensor makes its various disk 
assessments.

This tab contains the following:

Time Between Disk Doctor Checks
Drag the slider or click anywhere on the slider bar to change how frequently the sensor checks the 
integrity of the file structures on the disk.

Time Between SMART Checks
Drag the slider or click anywhere on the slider bar to change how frequently the sensor checks the 
status of the disk drive hardware. SMART checks can only be performed on drives that support 
SMART.

Time Between Disk Image Checks
Drag the slider or click anywhere on the slider bar to change how frequently the sensor checks to 
ensure the disk's Image information is current.

Default
Resets all Disk Health sensor scans back to their default intervals.

{button ,AL(`To set sensor measurement method;sd32 properties dialog;About the Disk Doctor 
sensor;About the Disk Doctor Surface test sensor;About the Image sensor;about the disk smart 
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Drag the slider or click anywhere on the slider bar to change how frequently the sensor checks the 
integrity of the file structures on the disk.



Drag the slider or click anywhere on the slider bar to change how frequently the sensor scans the disk 
surface for physical errors.



Drag the slider or click anywhere on the slider bar to change how frequently the sensor checks the status 
of the disk drive hardware. SMART checks can only be performed on drives that support SMART (Self-
Monitoring, Analysis, and Reporting Technology).



Drag the slider or click anywhere on the slider bar to change how frequently the sensor checks to ensure 
the disk's image information is current.



Resets all Disk Health sensor scans back to their default intervals.



Properties: Drive tab

The Drive tab lets you specify the drive for this sensor to monitor, and configure how frequently the 
drive is scanned.

This tab contains the following:

Monitor All Local Hard Drives
Click to have this sensor monitor all local hard drives (excluding removable media drives, such as 
Iomega's Zip  and Jaz

 drives). This option is not available for all sensors.
Monitor A Particular Drive
Click to have this sensor monitor a single drive only. This option is not available for all sensors.
Drive List
To monitor a particular drive, click a drive in this list. To monitor several different drives using separate 
sensors, add a new sensor for each drive.

Time Between Scans
Drag the slider or click anywhere on the slider bar to change how frequently the sensor scans the 
disk.

The Disk Doctor and Disk Optimization sensors get their information from the same disk scan. 
Consequently, adjusting the slider setting for one of these sensors, affects the scan for both.

Rescan Delay
Drag the slider or click anywhere on the slider bar to change how long the sensor waits before 
rescanning after a scan is interrupted (or if a scan cannot be performed) because of other system 
activity.

The Disk Doctor and Disk Optimization sensors get their information from the same disk scan. 
Consequently, adjusting the slider setting for one of these sensors, affects the scan for both.

Default
Resets all drive properties back to the defaults.

{button ,AL(`sd32 properties dialog;To set the drive to be monitored',0,`',`')}    Related Topics



Properties: Drive tab (Norton AntiVirus SE sensor)

The Drive tab lets you specify the drive for this sensor to monitor, and configure how frequently the 
drive is scanned.

This tab contains the following:

Monitor All Local Hard Drives
Click to have one sensor monitor all local hard drives (excluding removable media drives , such as 
Iomega's Zip  and Jaz

 drives).
Monitor A Particular Drive
Click to have this sensor monitor a single drive only. You can still monitor several drives for viruses by 
adding a Norton AntiVirus SE sensor for each drive.
Drive List
If you choose to monitor a particular drive, choose the drive from this list.

Time Between Drive Scans
Drag the slider or click anywhere on the slider bar    to change how frequently the sensor scans the 
drive for viruses.

Time Between Memory Scans
Drag the slider or click anywhere on the slider bar to change how frequently the sensor scan the 
computer memory for viruses.

Default
Resets all drive properties back to the defaults.

{button ,AL(`sd32 properties dialog;To set the drive to be monitored',0,`',`')}    Related Topics



Properties: Files To Scan tab

This tab lets you specify the file types that are scanned for viruses.

This tab contains the following:

File Extension List
Lists the file types that the Norton AntiVirus SE Scan sensor checks for viruses. The file extension 
is that part of the filename following the last period. Click a file extension in the list to highlight it for 
removal from the list.

Add
Click to add a new file extension to the list.

Remove
Click to remove a file extension from the list of file types to be scanned. This option is disabled until 
a file extension is selected in the list.

Default
Resets all Files To Scan properties back to the defaults.

{button ,AL(`sd32 properties dialog;about the Norton AntiVirus SE Scan sensor;To specify files to be 
scanned for viruses',0,`',`')}    Related Topics



Properties: Site tab

This tab lets you specify the Internet site Norton System Doctor will use to judge the speed of network 
transmission over the Internet.

This tab contains the following:

Site To Monitor
Type the host name or IP address of the site Norton System Doctor should monitor for Internet 
transmission speed. Checked regularly, these sensors can give you an indication of the best time to 
access specific sites.

{button ,AL(`sd32 properties dialog;about the internet packet turnaround sensor;about the internet 
speedometer sensor',0,`',`')}    Related Topics



Properties: Item To Monitor

This tab is available only for the Windows Performance Stats sensors. It lets you choose the type of 
performance sensor to add. The categories and items available reflect those provided by the Windows 
System Monitor program.

This tab contains the following:

Category
Click the category of performance data to monitor. The specific categories available depend on 
your system configuration. At a minimum, the list box includes File System, Kernel, and Memory 
Manager.

Item
Click the specific type of performance data to monitor. When you click OK, a sensor for the selected 
item is added to the Norton System Doctor window. You can add multiple sensors to monitor 
different types of performance data provided by Windows.

Description
Describes what the item measures.

Title
Displays the title that appears with this sensor if you use the large sensor style. You can type a 
different title.

Abbreviated Title
Displays the title that appears with this sensor if you use the small sensor style. You can type a 
different title.

Default
Resets all Item To Monitor properties back to the defaults.

{button ,AL(`sd32 properties dialog;About Windows Performance Stats sensors;To monitor Windows 
performance statistics',0,`',`')}    Related Topics



Options: Sensor Appearance

Scheme
Click the box to list the available display schemes. A scheme defines the sensor dimensions, 
colors, text fonts, and background bitmap use for the Norton System Doctor window. You can 
choose one from the list, or use this tab to create a new scheme.

Save As...
Saves the sensor dimensions, colors, text fonts, and background bitmap currently set on this tab as 
a new display scheme. After you specify a name for the new scheme, it will appear in the list. You 
can switch Norton System Doctor between display schemes at any time.

Delete
Deletes the selected display scheme.

Settings
The sample graphic shows how all small-style sensors will look with the current appearance 
options. The large-style sensors are always twice the width of the small-style sensors. Use the 
horizontal and vertical sliders to change the sensor dimensions.

Item
Click the box to show a list of sensor components. Click a component from the list to change its 
color or font.

Color
Click to specify the color assigned to the selected sensor component.

Font
Click to specify the font used for text or calendar text.

Bitmap Background
Type the path and name of a bitmap to be used as the background image for all sensors, or click 
the folder icon  to browse your system for a bitmap.

The background bitmap feature is enabled only if your Windows display options are set to show 
more than 256 colors.

Default
Resets all Sensor Appearance properties back to the defaults.

{button ,AL(`sd32 Options dialog;To create display schemes;To set sensor size',0,`',`')}    Related Topics



Options: Window Settings

Docked
Click to dock the Norton System Doctor window, snapping it to the edge of the display. You can 
drag the docked window to any of the four edges of the display. Though the menu bar is hidden, 
you can access all menu options by right-clicking to display a context menu.

Auto Hide
When Norton System Doctor is docked, you can have it automatically collapse to a thin gray line 
along the edge of the display to clear space on the desktop. Moving the mouse cursor against the 
line redisplays the full Norton System Doctor window.

Norton System Doctor and the Windows taskbar cannot both be set to auto hide along the same 
edge of the screen.

Normal
Click to have Norton System Doctor show as a normal, undocked window.

Show Title Bar
Check to show the Norton System Doctor window title bar. When the title bar is hidden, you can 
restore it by right-clicking any sensor and choosing Show Title Bar from the View menu, or double-
clicking any sensor-free area in the Norton System Doctor window.

Show Symantec Logo
Check to show the Symantec logo bar alongside the Norton System Doctor window.

Always On Top
Check to keep Norton System Doctor visible over any other windows.

Sensor Order
Shows the order of the sensors currently displayed in the Norton System Doctor window. To change 
a sensor's position in the window, click the sensor in the list and use the Up and Down buttons to 
control its position relative to the other sensors.

You can also move any sensor directly, by holding down the Control (Ctrl) key, and dragging the 
sensor to a new position in the window.

Start Automatically With Windows
Click to have Norton System Doctor start automatically whenever windows is started.

Start Minimized
Click to have Norton System Doctor always start minimized. Norton System Doctor appears as an 
unobtrusive icon in the notification area at the Windows taskbar. To show the Norton System Doctor 
window, click the icon.

You can also control many of these options directly from the View menu, or by choosing View 
from any sensor's context (right-click) menu.

Default
Resets all Window Settings properties back to the defaults.

{button ,AL(`sd32 Options dialog;To dock and auto hide Norton System Doctor;To arrange sensors 
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Options: Active Sensors

Available Sensors
Lists all the Norton System Doctor sensors. To add new sensors to the Norton System Doctor 
window, click the sensor name in this list, then click Add.

Current Sensors
Lists the sensors that currently appear in the Norton System Doctor window. You can configure any 
sensor in the list by clicking the sensor name then clicking Properties. You can remove any of these 
sensors from the Norton System Doctor window by clicking the sensor name then clicking Remove.

You can also add and remove sensors by using the Sensors menu, or by choosing Add Sensor 
from any sensor's context (right-click) menu.
Smart Scans
Smart Scans let Norton System Doctor intelligently yield to any mouse or keyboard input that occurs 
during its various system scans. This keeps system maximally responsive during the scans. If you would 
prefer the scans to occur faster, and are willing to sacrifice some system responsiveness during the scan 
process, uncheck this option.

Default
Resets Norton System Doctor to display the default Active Sensors.

{button ,AL(`sd32 Options dialog',0,`',`')}    Related Topics



Smart Scans let Norton System Doctor intelligently yield to any mouse or keyboard input that occurs 
during its various system scans. This keeps system maximally responsive during the scans. If you would 
prefer the scans to occur faster, and are willing to sacrifice some system responsiveness during the scan 
process, uncheck this option.



Options: Alarms

Alarm Type
Click the box to see a list of the types of alarm messages available in Norton System Doctor:

Notices
Least severe alarms. They frequently indicate situations that cause poor system performance. Alarm 

conditions that generate Notices will not compromise your data. Reminders, such as those to update the 
disk image or get software updates also appear as Notices.

Cautions 
Flag situations that can potentially compromise data, such as low disk space, or disk surface errors. 

When Cautions appear, you should save your work immediately and correct the situation causing the 
alarm.

Alerts
Warn you of serious conditions that should be attended to immediately. If Norton System Doctor detects 

numerous disk errors, an imminent disk hardware failure, or a virus infection, it displays an Alert message.

To change the behavior of a specific type of alarm message, click it in the list, and choose the 
behavior below.

Show Alarm Message On Top Of All Windows
Click to have the selected type of alarm message display on top of other windows. You can 
continue to work in other applications, though the Norton System Doctor messages will be visible.

Show Alarm Message In The Background
Click to have the selected type of alarm message display in the background. If you have another 
application open on the desktop, you will not see alarm messages set to display in the background. 
Using this display option for Cautions and Alerts is not recommended.

Default
Resets all Norton System Doctor alarm messages to their default display types.

{button ,AL(`sd32 Options dialog;To change the behavior of alarm messages',0,`',`')}    Related Topics



Click the box to see a list of the types of alarm messages available in Norton System Doctor:

Notices
Least severe alarms. They frequently indicate situations that cause poor system performance but will 

not compromise your data.
Cautions

Flag situations that can potentially compromise data, such as low disk space, or disk surface errors. 
When Cautions appear, you should save your work immediately and correct the situation causing the 
alarm.

Alerts
Warn you of serious conditions that should be attended to immediately. If Norton System Doctor detects 

numerous disk errors, an imminent disk hardware failure, or a virus infection, it displays an Alert message.



Click to have the selected type of alarm display on top of other windows. You can continue to work in 
other applications, though the Norton System Doctor messages will be visible.



Click to have the selected type of alarm display in the background. If you have another application open 
on the desktop, you will not see alarm messages set to display in the background. Using this display 
option for Cautions and Alerts is not recommended.



Resets all Norton System Doctor alarm messages to their default display types.



About the WinDoctor sensor

This sensor uses Norton WinDoctor to periodically scan your system for the most common types of 
Windows problems. If problems are detected, the sensor can alert you, or open WinDoctor 
automatically to repair the problems.

WinDoctor does the following:

Inspects everything that's required for Windows to run properly, and keeps Windows running at 
peak efficiency.

Checks for components needed by the programs you run under Windows.
Displays an easy-to-read report that lists the problems it found, the problems it fixed, and the 

severity of each problem.
Lets you tailor the repair process. You can specify which problems to fix and how to fix them. Or, 

you can just choose to fix all found problems automatically and let Norton WinDoctor take care of 
everything.

If you decide you don't like a repair Norton WinDoctor has made you can undo it. Even repairs you 
made in previous sessions can be reversed by using WinDoctor's Undo History feature.

You should not add multiple WinDoctor sensors to the Norton System Doctor sensor panel.

{button ,AL(`Introducing Norton System Doctor;Types of sensors;Types of system sensors',0,`',`')}    
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WinDoctor sensor

Uses Norton WinDoctor to periodically scan your system for the most common types of Windows 
problems. If problems are detected, the sensor can alert you, or open Norton WinDoctor automatically to 
repair the problems.



About the CrashGuard+ sensor

This sensor alerts you to system crashes, and monitors virtual memory, GDI, and USER resources.

The CrashGuard+ sensor uses Norton CrashGuard to alert you to application crashes as they happen. 
CrashGuard runs in the background and monitors the system for crashes. It lets you save any unsaved 
data before closing down programs, and can recover your system from most software crashes.

Norton CrashGuard includes Anti-Freeze, a program that can often restore frozen applications (those 
that remain on screen, but no longer respond to input).

You should not add multiple CrashGuard+ sensors to the Norton System Doctor sensor panel.
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CrashGuard+ sensor

Alerts you to system crashes, and monitors virtual memory, GDI, and USER resources.

This sensor uses Norton CrashGuard, which runs in the background and monitors the system for crashes. 
CrashGuard lets you save any unsaved data before closing down programs, and can recover your 
system from most software crashes.



Click to configure the Norton Utilities program used to make automatic repairs.

This option is not available for all sensors.



Virtual Memory Sensor

This sensor reports the amount of disk space available for use as virtual memory. Potential virtual 
memory includes any free space on the disk, plus some portion of the space that has been already 
reserved for the Windows swap file (that portion currently unused for temporary data storage).



Swap File Utilization sensor

Shows how much of the space reserved for the Windows swap file is currently in use for temporary data 
storage.



Click to have this sensor monitor all local hard drives (excluding removable media drives , such as 
Iomega's Zip  and Jaz

 drives).



Click to have this sensor monitor a single drive only. Choose the drive from the list below.



Check to have Norton System Doctor automatically choose an appropriate trigger level based on the 
amounts of used space and fragmentation on the disk.



Drag the slider or click anywhere on the slider bar    to change how frequently the sensor scans the drive 
for viruses.



Drag the slider or click anywhere on the slider bar to change how frequently the sensor scan the 
computer memory for viruses.



To change the behavior of alarm messages

Norton System Doctor includes four basic types of alarm messages: Notice, Caution, Alert, and Crash 
messages. You can determine how noticeable each type of message is, except Crash messages. 
These always display on top.

1 Click here        to open Norton System Doctor.

2 Choose Options from the View menu
3 Click the Alarms tab.
4 Click the Alarm Type box to choose the alarm type whose behavior you want to change.
5 Click Show Alarm Message on Top of all Windows, or Show Alarm Message in the Background.
6 Repeat for each message type.
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About alarm messages

When a sensor alarm is triggered, Norton System Doctor displays an alarm message to alert you of the 
condition. There are four basic types of alarm messages:

Notices
Least severe alarms. They frequently indicate situations that cause poor system performance. Alarm 

conditions that generate Notices will not compromise your data. Reminders, such as those to update the 
disk image or get software updates also appear as Notices.

Cautions
Flag situations that can potentially compromise data, such as low disk space, or disk surface errors. 

When Cautions appear, you should save your work immediately and correct the situation causing the 
alarm.

Alerts
Warn you of serious conditions that should be attended to immediately. If Norton System Doctor detects 

numerous disk errors, an imminent disk hardware failure, or a virus infection, it displays an Alert message.
Crash

Alert you to system crashes as they happen. CrashGuard runs in the background monitoring the 
system, and can recover from most software crashes. Crash messages let you save any unsaved data 
before closing down programs. (You cannot change the display behavior of Crash messages.)

You can control whether each type of message is displayed on top of all other windows on the desktop, 
displayed behind the applications you're currently working in, or not displayed at all.
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To disable Advanced Power Management

Advanced Power Management is supported by some systems, and allows them to better manage their 
energy use. APM is especially useful for portable computers, where battery life is a real concern.

For desktop PCs, APM can aid energy conservation, however it sacrifices some CPU cycles, causing 
the CPU usage to be higher than it otherwise would. To take some of the load off of a desktop system's 
CPU, APM can be safely disabled.

    You should not disable APM for portable PCs.
1 Click here        to open the Windows Device Manager.
2 Click the plus sign next to System Devices.
3 Double-click Advanced Power Management Support.
If you don't see a listing for Advanced Power Management Support, your computer does not support 
APM.
4 Click the Settings tab.
5 Uncheck Enable Power Management Support.
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Causes Norton System Doctor to appear in a standard, non-docked window.



Memory Virus Detected!

Norton System Doctor detected a virus in computer memory. Norton AntiVirus SE (Starter Edition), 
included with Norton Utilities, prevents crashes by finding and fixing virus-infected files, but cannot 
repair virus infections in memory. For complete virus protection, get Norton AntiVirus from your local 
reseller, direct mail vendor, or from the Symantec website at http://www.symantec.com.

Use your write-protected rescue disk set, Windows Startup disk, or a write-protected DOS 3.1 or higher 
system disk to reboot your computer before running any antivirus program to remove the virus.

You can also create a bootable floppy disk on an uninfected computer that uses DOS 3.1 or higher.

Do not use the infected computer to make a bootable floppy-disk. The virus could infect the 
bootable floppy disk you are trying to create.
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Boot Virus Detected!

Norton System Doctor detected a boot virus on your computer. Norton AntiVirus SE (Starter Edition), 
included with Norton Utilities, prevents crashes by finding and fixing virus-infected files, but cannot 
repair boot viruses. For complete virus protection, get Norton AntiVirus from your local reseller, direct 
mail vendor, or from the Symantec website at http://www.symantec.com.

Once the boot virus has been removed, use Norton AntiVirus to scan all of your floppy disks for viruses 
to ensure you don't re-infect your computer in the future.
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To open Norton System Doctor

You can open any of the Norton Utilities programs from the Norton Utilities Integrator. To open Norton 
System Doctor:

1 Double-click Norton Utilities Integrator on the Windows desktop.

2 Click Preventative Maintenance in the left pane of the Norton Utilities Integrator.

3 Click Norton System Doctor in the right pane.

Or click here 
    to open Norton System Doctor now.
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Check this box to schedule the repair for a later time. Type the time you want the repairs performed in the 
box provided.

This option is not available for all sensors




